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1.	CE+T Power at a glance
CE+T Power is your trusted partner in advanced power solutions engineered to meet the demands of modern and 
dynamic industrial applications. With over 60 years of experience in power conversion technology, CE+T Power nurtures 
the industry with innovative solutions designed for critical power backup and energy management.

Our complete range of power solutions includes modular inverters (DC to AC), UPS (securing AC loads with batteries), 
and multidirectional converters (inverter, rectifier, and UPS all-in-one). Coupled with our state-of-the-art monitoring 
solution, you have a real energy blender to connect multiple sources of energy seamlessly!

Whether you require robust backup power solutions, energy management solutions, or a combination of both, CE+T 
Power delivers tailored solutions to meet your specific needs. Our products are designed with integration in mind, 
ensuring seamless compatibility with other components of your system. CE+T Power is committed to providing you 
with the expertise and resources needed to maximize the performance of your power systems.

Thank you for choosing CE+T Power as your partner in advanced power management. Let’s power the future together.

CE+T Power at a glance
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2.	Abbreviations 
AC		  Alternating current

DC		  Direct current

DHCP		  Dynamic Host Configuration Protocol

DSP		  Digital Signal Processor

ECI		  Enhanced Conversion Innovation

EPC		  Enhanced Power Conversion

ESD		  Electro Static Discharge

ETH		  Ethernet

HTTP		  HyperText Transfer Protocol

HTTPS		  Secure HyperText Transfer Protocol

LAN		  Local Access Network

MBB		  Measure Box Battery

MBP		  Manual By-pass

MET		  Main Earth Terminal

MIB		  Management Information Base

N		  Neutral

NTP		  Network Time Protocol

NUA		  Non-Urgent Alarm

PCB		  Printed Circuit Board

PE		  Protective Earth (also called Main Protective Conductor)

PWR		  Power

REG		  Regular

SNMP		  Simple Network Management Protocol

TCP/IP		  Transmission Control Protocol/Internet Protocol

TRS		  True Redundant Structure

TSI		  Twin Sine Innovation

UA		  Urgent Alarm

USB		  Universal Serial Bus

Abbreviations 
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3.	Warranty and Safety Conditions*

The electronics in the power supply system are designed for an indoor, clean environment. 

When installed in a dusty and/or corrosive environment, outdoor or indoor, it is important to:

	• Install an appropriate filter on the enclosure door or on the room’s air conditioning system. Installation of filters 
may result in de-rating of module.

	• Keep the enclosure door closed during operation.

	• Replace the filters on a regular basis.

Important Safety Instructions, Save These Instructions.

3.1	 Disclaimer
	• The manufacturer declines all responsibilities if equipment is not installed, used, or operated according to the 

instructions herein by factory certified technicians according to local regulations.

	• Warranty does not apply if the product is not installed, used, and handled according to the instructions in the 
manuals.

3.2	 Technical care
	• This electronic equipment can only be repaired or maintained by a “qualified employee” with adequate training. 

Even personnel who are in charge of simple repairs or maintenance are required to have knowledge or 
experience related to product maintenance. 

	• Please follow the procedures contained in this Manual, and note all the “DANGER”, “WARNING” AND “NOTICE” 
marks contained in this Manual. Warning labels must not be removed.

	• Qualified employees are trained to recognize and avoid any dangers that might be present when working on or 
near exposed electrical parts. 

	• Qualified employees understand how to lock out and tag out machines so the machines will not accidentally be 
turned on and injure employees working on them. 

	• Qualified employees also understand safety related work practices, including those by OSHA and NFPA, as well 
as knowing what personal protective equipment should be worn. 

	• All operators are to be trained to perform the emergency shut-down procedure.

	• Never wear metallic objects such as rings, watches, or bracelets during installation, service and maintenance of 
the product.

	• Insulated tools must be used at all times when working with live systems.

	• When handling the system/units pay attention to sharp edges.

*  These instructions are valid for most CE+T Products/Systems. Some points might however not be valid for the 
product described in this manual.

Warranty and Safety Conditions
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3.3	 Installation
	• This product is intended to be installed only in restricted access areas.

	• The user must observe the recommended upstream and downstream circuit breaker requirements as per the 
local regulations. 

	• Please use extreme caution when accessing circuits that may be at hazardous voltages or energy levels.

	• The modular inverter rack is a dual input power supply. The complete system shall be wired in a way that both 
input and output leads can be made power free.

	• In REG systems, to comply with local and international safety standards the N (output) and PE shall be bonded. 
The bonded connection between N (output) and PE must be removed once the AC input is connected.

	• AC and DC circuits shall be terminated with no voltage / power applied.

	• The safety standard IEC/EN62040-1-1 requires that, in the event of an output short circuit, the inverter must 
disconnect in 5 seconds maximum. The parameter can be adjusted on T2S ETH monitoring; however, if the 
parameter is set at a value > 5 seconds, an external protection must be provided so that the short circuit 
protection operates within 5 seconds. Default setting is 60 seconds.

	• The system is designed for installation within an IP20 or IP21 environment. When installed in a dusty or humid 
environment, appropriate measures (air filtering) must be taken. Installation of filters may result in de-rating of 
module.

	• All illustrations in the manual are for general reference, refer to the technical drawing which is received along 
with the system for exact information.

3.3.1	 Handling

	• The cabinet shall not be lifted using lifting eyes.

	• Remove weight from the cabinet by unplugging the inverters. Mark inverters clearly with shelf and position for 
correct rebuild. This is especially important in dual or three phase configurations.

	• Empty T2S positions should not be left open. Replace either with a T2S or blank cover.

3.3.2	 Surge and transients

The mains (AC) supply of the modular inverter system shall be fitted with Lightning surge suppression and Transient 
voltage surge suppression suitable for the application at hand. Manufacturer’s recommendations of installation shall 
be adhered to. Selecting a device with an alarm relay for function failure is advised.

Indoor sites are considered to have a working lightning surge suppression device in service.

	• Indoor sites Min Class II.

	• Outdoor sites Min Class I + Class II or combined Class I+II. The modular inverter system/rack can reach 
hazardous leakage currents. Earthing must be carried out prior to energizing the system. Earthing shall be made 
according to local regulations.

3.3.3	Other
	• Isolation test (Hi-Pot) must not be performed without instructions from the manufacturer.

Warranty and Safety Conditions
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3.4	 Pre-cautions before maintenance 
	• The modular inverter system/rack can reach hazardous leakage currents. Earthing must be carried out prior to 

energizing the system. Earthing shall be made according to local regulations.

	• Prior to any work conducted on a system/unit make sure that AC input voltage and DC input voltage are 
disconnected. 

	• Inverter modules and shelves contain capacitors for filtering and energy storage. Prior to accessing the system/
modules after power down, wait at least 5 minutes to allow capacitors to discharge.

	• Some components and terminals carry high voltage during operation. Contact may result in fatal injury.

3.5	 Replacement and Dismantling
	• ESD Strap must be worn when handling PCBs and open units.

	• CE+T cannot be held responsible for disposal of the Inverter system and therefore the customer must segregate 
and dispose of the materials which are potentially harmful to the environment, in accordance with the local 
regulations in force in the country of installation.

	• If the equipment is dismantled, to dispose of its component products, you must comply with the local regulations 
in force in the country of destination and in any case avoid causing any kind of pollution.

To download the latest:

	• Documents - www.cet-power.com

	• Softwares - my.cet-power.com

Warranty and Safety Conditions
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4.	Product Code and Identification
T2S-ETH product code with regards to sub rack:

A)	 T2S-ETH Monitor

Product Description Part Number

TSI-T2S-ETH-NOVA - VEDA T312010010

TSI-T2S-ETH-BRAVO-MEDIA 24/48 Vdc T322010100

TSI-T2S-ETH-BRAVO-MEDIA 60/110/220 Vdc T322051000

B)	 Filler (Blank module to cover empty slots)

Product Description Part Number

TSI-T2S-ETH-NOVA - VEDA T312010001

BLANK PLASTIC T2S ETH ECI RED T522010001

4.1	 Identification labels for T2S-ETH

Note:

The part number, serial number, and burn in date are essential information when you contact CE+T to get help in 
commissioning or in troubleshooting or when the item is sent back for repair.
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5.	Introduction
The T2S ETH stands for T2S Ethernet. It replaces the former T2S with the same form factor but with a front Ethernet 
connector replacing the former USB one. Like his predecessor, T2S ETH is a monitoring solution for the full TSI inverter 
range and is able to monitor up to 32 inverters through a friendly web-based interface and it consumes power of 2W. 
T2S also supports Modbus Serial communication (RTU) and SNMP v1 Communication. 

This new monitoring device provides a graphical user interface, embeds an SNMPv2c/SNMP v3 agent, and Modbus 
TCP support with Inview X. 
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6.	Hardware

6.1	 T2S ETH
The T2S ETH provides 3 LED’s: Red for major alarm signaling, orange led for minor alarm signaling, and green led for 
power and network connection status.

The RJ45 is a standard ETH connector that could be connected to any IPv4 network.

T2S ETH software can be upgraded using the Micro SD card. The latest device softwares are available in  
my.cet-power.com

Major Alarm 

Ethernet Port

System Status
Minor Alarm

Micro SD Card

http://my.cet-power.com
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6.1.1	 LEDs code during operations

S - Flash slow

FS - Flash fast

SA - Sequence one after the other

X - Not used LED

6.1.1.1	 LEDs code during normal operation

LEDs code below corresponds to system in operation and T2S ETH fully operational.

Green Orange Red Status

S Slave mode (when several T2S ETH on the same bus)

Master Mode « master » 

Minor alarm

Major alarm

6.1.1.2	 LED Error Code - upgrade or system start up

This section explains the state of the boot loader in function of his LED state. During start up, soft upgrade, 
configuration change or micro SD card changes.

Green Orange Red Status

Booting

Cannot copy to flash

FS No micro SD card or file *.bcf not valid or not present

File *.acf found 

SA SA Installation *.saf please wait

FS System error or no micro SD card

S FS Configuration.ini found waiting network



Hardware

15 - Monitoring - T2S ETH with Inview X- User Manual - v3.2

Green Orange Red Status

FS Boot loader Web interface ON and in operation

S FS System file OK but no config file *.ini

S S S Error SD Card / File

S S Error no configuration.ini

6.1.2	 Signaling Information

As it is designed to be used in the same shelf as former T2S, T2S ETH inherits the connections on the back.

Note: The terminal connector accepts maximum wire size of 0.5 mm2.

Important remarks: 

In a system with several shelves, T2S ETH is usually located in the top (although it is not mandatory), but relay 
signaling contacts will be terminated in the T2S ETH installed shelf. The above connection is an example, actual 
connection will be based on your shelf design and connections.

If the T2S ETH is included in a complete system, the alarm terminals will be located somewhere in the system. For 
exact location, refer to the system user manual.
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6.1.2.1	 Alarm relay

There are 3 alarm contacts: 

	• Major 

	• Minor 

	• User selectable

As one can see in the picture: contacts 5 and 6 are closed when no major alarm is present, 
contact 8 and 9 are closed when no minor alarm is present.

Remark: Default mapping and level of each available alarm of the monitoring unit is 
available in “Annex 1: Supervisor alarms - T2S ETH”, page 65.

NB:  Alarm relay are active (energized) when no alarm are present. 

	• Alarms relay features 

 � Max current:	 2 A @ 30 VDC or 1A @ 60 VDC

 � Max Power:	 60 W

 � Max Voltage:	 60 VDC SELV

Note that for higher voltages, it is mandatory to install an additional relay with appropriate characteristics – especially 
for 60/110/220 VDC.

6.1.2.2	 Digital Inputs

Two potential free Digital inputs are reserved for optional equipment.

	• Digital Input 1 is assigned for MBP operation if used.

	• Digital Input 2 is assigned for Surge Arrester if used.

The voltage present on terminal 1 and 3 is +5 V (galvanic insulation). Care should be taken to avoid connecting any 
external voltage on terminal 1 to 3. External signals should be applied to these terminals via Volt-free contacts. The 
function is activated when the two terminals concerned are short-circuited (i.e., when the external Volt-free contact is 
closed).

6.1.2.3	 Communication

An RJ45 connector is present at rear of the shelf and can be used for Modbus (RTU) communication.
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Note: The colour of wires is irrelevant and may vary, but make sure the position of wires is exactly crimped.

Pin Number Name Description

1 CANH CANH pin for Candis

2 CANL CANL pin for Candis

3 GND_IAX Digital Communication Ground

4 GND_IAX Digital Communication Ground

5 12V_IAX +12 V unregulated

6 COM_A RS 485 A

7 GND_IAX Digital Communication Ground

8 COM_B RS 485 B

RJ45 Pinout - Details

Important remark: 

T2S ETH comes in only one type in terms of serial communication RS485 and support Modbus RTU (read-only).

Currently, no protocol is available for customer use on CAN bus connection.

The unregulated +12 V power supply is designed for powering CE+T accessories and should not be used for any other 
purpose.
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6.2	 Monitoring - Inview X
Inview X is an advanced monitoring and controller unit for power systems. It 
allows the user to easily view and access the system information through LCD 
screen graphic display and configure through web interface. The home screen 
of both LCD and web interface provides a summary of system power, batteries, 
and events information.

Inview X is a 7” LCD touch screen display.

Please note that the Inview X is not master and can be removed during operation without affecting the 
system operating as UPS. Make sure that the sotware version of the Inview X is 6.3.0 or above, in order to 
be compatible with T2S.

6.2.1	 Inview X - Connections

Inview X has multiple network ports and inbuilt free potential contacts.

ETH1

ETH2

PWR

ETH Front

+ PE - + PE -

	• ETH ports are used for network connectivity, and user can access the system information through the web 
interface. 

 � ETH Front: DHCP server, providing access to the configuration at URL https://inview.local or 
https://10.250.252.1 

 ○ Intended for direct connection of a laptop computer. 
Warning: Do not connect this port to the network, as it might interfere with other DHCP servers.

 � ETH1: Main network interface

 ○ Default static IP address: 10.250.250.1/24

 ○ It can be configured to other static addresses or as a DHCP client in a web-based configuration 
interface

 � ETH2: Secondary network interface

 ○ Static IP address: 10.250.251.100/24 (or 192.168.0.3/24, if pre-configured to communicate with 
the T2S)

 ○ It is dedicated to T2S ETH and does not connect to the network 

	• Power: The unregulated separate +48V supply is required for powering Inview X. Two terminals are available for 
redundancy purpose.
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6.3	 Wiring
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7.	User Interface

7.1	 Network architecture
When using Inview X with T2S ETH, the network architecture is the following:

“A” is a private network between Inview X and T2S ETH. Inview X provides a proxy IP address to T2S ETH. 

“B” is the user “permanent network connection” to the Inview X. It can be either in DHCP client or in fixed IP address. 
When using a Inview X, the customer can access T2S ETH interface through the proxy.”

7.2	 Inview X Web UI
Open the web browser and type the default IP address 10.250.250.1/
site (or inview.local if ETH Front is used on Inview X) in the address 
field and press enter.

Inview X has three login – Basic, Expert and Admin. All three logins are 
password protected.

The default password for all three logins is “1234”. It can be modified, 
refer to Inview user manual for more details.

NOTE: The user is not allowed to modify any converter system 
parameter inside the Inview X Web UI.
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7.3	 T2S ETH - Inview X configuration
When a complete system is bought from CE+T, the communication between T2S ETH and Inview X is already 
configured in the factory. If the products are bought as A la carte, establish the communication by following the below 
procedure. 

	• Go to Inview X web UI, select Advanced view > Site > Configuration.

	• Scroll down to ‘Network’ and make sure that the parameter CF340 value is 192.168.0.3/24.

	• Scroll down to ‘Ethernet’ and make sure that the parameter CF220 value is CATENA(192.168.0.2,es1_invs1).

	• If the T2S ETH IP address is changed by the user, then CF340 and CF220 values must be modified accordingly.

	• Ensure that the Dashboard and data are on the GUI screen.

	• Type the IP address 10.250.250.1 in the address bar and check that the web interface is in Catena mode.

	• To go back to the network configuration of Inview, browse to 10.250.250.1/site.
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7.4	 T2S Web UI
NOTE: The controller will perform a short self-test as it boots up. Alarm alerts are normal. 

	• Initiate the start-up routine by applying power to the T2S ETH (close protection breaker powering the controller). 

	• Use a laptop to connect to the system.

After proper configuration of Inview, the T2S ETH web UI can be accessed through http://10.250.250.1 when the 
laptop is connected to ETH1 port.

There are two access levels:

	• Basic login can be used only to browse the pages and 
download the files. It does not require a password.

	• Expert login can be used to access and also modify the system 
parameter values. The default password is pass456 but it 
is strongly advised to change that password. To modify the 
password, refer to “Passwords”, page 32.

NOTE: System modification and setting may result in alarm event. Be 
careful while applying modification. 

An auto-logout feature is available to avoid a user being connected all the time, blocking the system. Refer section 
“Regional settings”, page 31 for more information.

In case of lost password, please refer to FAQ at page 60 

7.5	 Interface Areas
1 	 Banner

2 	 Main Area

3 	 Tool bar

1

2

3
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7.5.1	 Banner

1 2 3
4

1 	 T2S Mode � 
T2S ETH can be used redundant (2 in the same system), one being master, the second is a slave. 
When used alone, T2S ETH automatically becomes master.

2 	 Site name� 
It’s a customizable field from the configuration menu. Users can set any string as required.

3 	 Access level� 
Display the level in use to browse the interface. It can be either Expert or Basic.

4 	 Date and time� 
This is the device time and date which can be adjusted in configuration menu.

7.5.2	 Main Area

1

2

3

4

5

6

The above screen is a “Classic” home page, and the moving white ball appears, while the load consumes power from 
the module. While in the “Alternate” home page, displays brief information of the system.

1 	  AC IN � 

Clicking the magnifier  will bring the user to all measurements regarding the AC input. 
The LEDs show the status of the input: if the source is absent, this LED’s becomes red. 
Flowing (moving white ball) from this item to the system means power is taken from the source. 
The power displayed is the total power consumed, regardless of the system is 1P or 3P.

2 	  DC input � 

Clicking the magnifier  will bring the user to all measurements regarding DC input. 
Given the system can be configured with up to 2 DC groups, power is the total power consumption. 
Flowing (moving white ball) from this item to the system means power is taken from the DC source.
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3 	  System � 

Clicking the magnifier  will bring the user to information regarding the system, such as 
redundancy, available power, and so on. It is also the path to module level monitoring. 
The three LEDs are showing the state of each converter.  
Example: if any one of the internal converter of the module is in problem, then the led will turn to the 
corresponding color.

4 	 AC out � 

Clicking the magnifier  will bring the user to all measurements regarding AC Out. 
Regardless of the system configuration (1P, 3P), displayed power is the total amount of power fed to 
the load.  
Power is expressed in both KW and KVA, and the Power Factor (PF) is computed.

5 	 Gauge � 
In a 1P output system, the gauge depicts the percentage of power used in VA. 
In a “more than 1P” system, the gauge depicts the “worst case,” i.e., if the system is unbalanced, it 
shows the most loaded phase.

6 	 MBP � 
MBP is configured in the system.

7.5.3	 Toolbar

The tool bar is always accessible and provides quick access to the following pages:

	• Events page 
The events icon has the color of the highest priority alarm currently present in the system:

 � Green: system healthy, no event present.

 � Grey: at least one event is present in the system but not configured as major or minor.

 � Orange: at least one minor event present in the system. No major event but other events could be present 
also.

 � Red: at least one major event is present in the system. Other events or minor events could be present.

If more than one event is present, regardless of its level, a counter is present on the icon. It displays 
the total number of event currently present in the system.

	• Connections  
This brings to digital input and relays status. For configuring these inputs and outputs, it’s in the configuration 
section.

	• Files  
This leads to the file management page. Files such as configuration, update and log download.

	• Parameters  
The parameters page allows user to change every parameter related to the system.



User Interface

25 - Monitoring - T2S ETH with Inview X- User Manual - v3.2

Throughout the browsing, the user can see the following icons:

When accessing a page of depth of two or more (such as module or log page), the user can go back 
to previous page by clicking “back” icon

Clicking on “Home” icon goes to the home page from any page you are accessing in the interface.

Clicking on “Logout” icon goes to the login page

7.6	 Pages and Feature

7.6.1	 AC IN

This page displays the measurements 
made by the modules on the AC input.

Available values are:

Measure Unit

Voltage (V) Volts (V)

Current (I) Ampere (A)

Frequency(f) Hertz (Hz)

Input Power(P) Kilo Watts (kW)

The system also keeps track of last AC In 
failure timestamp.

Remark: 

Modules have a Power Factor of 1, that’s why power is only displayed in KW. This would be the same value in KVA. 
The Last AC in failure is non-persistent information. It means that it will be lost if the device is reset.

7.6.2	 DC IN

This page displays the measurements 
made by the modules on the DC input.

Available values are:

Measure Unit

Voltage (V) Volts (V)

Current (I) Ampere (A)

Input Power(P) Kilo Watts (kW)
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7.6.3	 AC Out

This page displays the measurements 
made by the modules on the AC output

Available values are:

Measure Unit

Voltage (V) Volts (V)

Current (I) Ampere (A)

Frequency(f) Hertz (Hz)

Active Power(P) Kilo Watt (KW)

Apparent 
Power(S)

Kilo Volt Ampere 
(KVA)

Power factor -

7.6.4	 System

Clicking the system picture on the home 
page brings the user to the related 
page, and the following information are 
displayed:

System level:

	• Installed power - It is the total 
power of the configured modules, 
including redundancy.

	• Available power -It is the total 
power of active modules present in 
the system.

Phase level:

For each output phase, the following 
information are given:

	• Number of installed modules

	• Redundancy: defined or not, satisfied or not

	• Installed and available power following the same logic as per system level

	• A.R.C. (Available Redundant Capacity) is the 
remaining available power before reach the 
redundancy level.

Clicking the  button will launch the module 
selection pop-up. Each module’s information can be 
accessed by clicking the corresponding button. A 
legend is always present to recall the color scheme:

	• White: no module in slot

	• Grey: module manually off
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	• Green: module OK

	• Orange: module in recoverable error

	• Red: module with unrecoverable error

For last two, refer to module manual for troubleshooting.

7.6.5	 Module
This page gives the module by 
module measurement. 

T2S ETH is the monitoring solution 
for inverters, which are all one 
phase module.

Many controls are available from 
this page to manage the module:

     

Users can set the module address as required between 1 and 32.

Clicking on this button, the corresponding module LED’s blink for few seconds. It helps to identify 
the module in the system and also the assigned phase of the module..

A module can be manually turned off through user interface. It will be still on the communication 
bus, but only the output is turned off. When you click on this button, it will change the state from 
display one to opposite.

T2S ETH keeps track of all modules which appear on the bus, and it means no installation is 
needed when a new module is plugged in. But when a module is removed, it’s mandatory to 
tell the system about it, by “uninstalling” it, clicking this button. If not, the system will detect a 
missing module and raise the alarm.

For each of its converters, the module can be assigned an AC in phase, an AC out phase and 
a DC group. User can do so by using this control number to each converter measures. Module 
should be manually off to do changes for AC out phases.

If module fan is replaced, click this icon to clear the corresponding alarm.
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7.6.6	 Events

The events page lists all events currently 
ongoing in the system. These are sorted 
by event occurrence time, and the latest 
event will be on top of the list. T2S ETH 
records maximum number of 2000 
events as FIFO.

“Device” column provides the source 
of the alarm, which can be down to 
converter of a given module (example: 
module 4 AC IN) to System or monitoring 
level.

Events appear with a color 
corresponding to their alarm level  
(Grey – event, orange – minor, red – 
major).

A filter, as shown below is available to display only a subset of these events.

7.6.7	 Log

Log file lists all events which have 
occurred in the system since last log 
clear.

Compared to the event page, an extra 
column display if event has appeared or 
disappeared.

For each event, there are two log lines: 
one with the timestamp of the event 
appearing and the second one with the 
timestamp of the event disappearing.

Users can filter the log like in event page. 

Users can see the difference between 
event and log page: no color for alarm 
level is used in log page, a column states 
it.

Log download and clear functions are available in “Files” menu.



User Interface

29 - Monitoring - T2S ETH with Inview X- User Manual - v3.2

7.6.8	 Connections

As described before, T2S ETH has two 
digital inputs and three alarm relays.

State of each of these connections can be 
read through the “connections” page.

An extra “toggle” allows the user to test 
each relay manually, toggling it for a few 
seconds to detect a mechanically failing 
device over time.

Note: For Digital Inputs, the inputs are 
active high and pulled to “0” on the 
alarm condition. Therefore, a TRUE state 
indicates the input is not active. A FALSE 
state indicates the input is active.

7.6.9	 Files

The Files page has three tabs.

The Transfer tab allows the user to 
download the log file and configuration 
files.

Users have the option to clear the log file 
by clicking “Clear” icon.

The Update tab allows the user to 
install the latest software version and 
get the latest features. Software is 
available through the CE+T customer 
area on the website (my.cet-power.
com).

Software are provided in a proprietary 
format called “*.saf” file. Once 
uploaded, the system will restart, 
installing the new application after 
verifications.

The dedicated procedure will be 
provided at the same location if needed. 
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The Language tab helps the user to 
upload a language file and translate the 
whole interface to the corresponding 
language. These files are available for 
certain languages in my.cet-power.com.

If the required language is not available, 
get in touch with sales representative to 
request the interface translation.

The first line Install language file 
allows uploading any language file while 
other lists are installed language. English 
is the default installed language. Apart 
from English, the user can install up to 
two different languages. Contact my.cet-
power.com to find supported Language 
packs.

7.6.10	 Parameters

The Parameters page is divided into multiple tabs, which are compound of sub menus. As shown below, the whole 
list of parameters, organized as in the interface with remarks and comments about their use.  Monitoring, Input relays, 
SNMP, Modbus, Power, and Info are the sub menus. 

Note: The following parameter sections provide brief information, to know more about each field, its function and 
values refer to section “16.  Annex 3: Configuration parameters - T2S ETH”, page 71.

Disclaimer: The configuration file should be manually edited only by CE+T crew or any especially trained operator.  
All modifiable values contained here are easily accessible through the T2S ETH web interface which allow you to 
change the configuration carefully. Any mistake done in this file could lead to system malfunction and CE+T shall not 
guarantee the behavior of the whole system once this file has been corrupted.

7.6.10.1	 Monitoring Tab

	• Time 

Time and date information of the 
T2S ETH system can be configured

Note: If the system has no power, 
the Real-Time Clock in T2S ETH 
can run up to 24 hours. After that, 
the clock will reset the date to 
01/10/2013 and time to 8.00.
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	• Regional settings

 � Language: users can select 
a language from the list. 
Refer the “Files” menu 
for installing the language 
pack.

 � Sitename: it’s a standard 
string that is displayed in 
the banner. 

 � Location is the place where 
the system is installed.

 � Auto logout delay: number 
of seconds after which 
any user will have to login 
again. 
When set to 0, auto-logout 
is disabled. A maximum 
value of 6000 seconds can be configured for the Auto-logout option.

 � Keyboard layout: useful when using a Inview X with the T2S ETH for in-display keyboard. It has two 
options AZERTY and QWERTY

 � New module identifier: Always Ask, Always replace and Never Replace are the options available for New 
Module Identifier.

 � Home page: Two different home page layouts are available and they are “Classic” and “Alternate” home 
page.

 � Display format: DD/MM/YYYY, YYYY/MM/DD, MM/DD/YYYY are the different display format available

 � Time format: 24 Hours and 12 Hours options are available. 

 � Temperature format: Celsius and Fahrenheit options are available.

	• NTP Server 

NTP Server: System date and 
time can be synchronized with 
NTP server. NTP configuration 
parameters.

 � IP Address of NTP server

 � Port Number

 � Time zone offset

 � Auto-refresh

 � Synchronization interval 
(days)

 � Force Synchronization. 
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	• Passwords

Expert password: default is 
“pass456” but it’s strongly 
recommended to change it. 

Software update do not change 
your password.

In case of lost password, please 
refer to FAQ at page 60

	• Network

In Connection mode, Select Hardware setup as “Standalone”. Do not select other options.

Network address is configuration of the T2S ETH

 � DHCP status: DHCP Disable allows configuring static IP to T2S ETH card.  
When DHCP is enabled, 
IP to T2S will be assigned 
by the DHCP server or the 
Router to which T2S ETH 
is connected. To find the IP 
address of T2S ETH card IP 
Scanner tools can be used. 
For more information refer 
section 8.3, page 43.

 � IP address

 � Subnet mask

 � Default gateway

 � Primary DNS 

 � Secondary DNS 

DNS has to be configured where server 
has host name.
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	• Alarms

MBP configured: If MBP is present 
in the system, this parameter 
should be configured and 
connected to Digital input 1. T2S 
ETH use this input to tell modules 
that MBP is engaged.

Remote MBP: It should be 
configured when a CE+T external 
MBP unit is present and it is 
applicable only for the systems in 
the US market. 
If it is enabled, the Relay 3 cannot 
be used.

Surge arrester configured: If a 
surge arrester is installed in the 
system, this parameter should 
be configured and connected to 
Digital input 2.

Log full alarms: Alarm will be generated once it reaches the maximum limit and record as FIFO.  
It is recommended to download the log.

7.6.10.2	 Input/Relays tab

	• Inputs Label

 � Digital Input 1: label for 
DigIn1

 � Digital Input 2: label for 
DigIn2

Note: If the digital input label name is 
other than “MBP ENGAGED” or “Surge 
Arrester”, it will display the given name 
in the web interface, but in the log file, 
it shows only as “Digital Input 1” and 
“Digital Input 2”.
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	• Relays Label

 � Major Relay Name: 
dedicated to major relay – 
not possible to change 

 � Minor Relay Name: 
dedicated to minor relay – 
not possible to change 

 � Relay 3 name: It is a 
programmable relay, and 
the user can select a 
particular alarm. 
Relay 3 cannot be used if 
remote MBP is enabled

 

	• Relays Delay

 � Major Relay delay: delay 
in seconds before toggling 
when the condition is met 
(major alarm present)

 � Minor Relay delay: delay 
in seconds before toggling 
when the condition is met 
(minor alarm present)

 � Relay 3 delay: delay in 
seconds before toggling 
when the condition is met.

	• Relays Mapping

 � Relay mapping page is a 
matrix: all events can be 
mapped on one relay, all 
relays can be mapped on 
one event, or any other 
combination the customer 
would like. 
 
Note: While selecting an 
alarm type for a relay, 
choose either Major or 
Minor. If both selected, only 
the major alarm will be 
enabled during that relay 
energized. 
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	• SNMP Traps

 � Traps can be enabled 
for different events and 
alarms under this section. 
Trap receiver configuration 
has to be done under the 
SNMP tab. 

 � Test Traps can also 
verified.

7.6.10.3	 SNMP

	• SNMP

SNMP configuration can be done 
from T2S ETH web page when 
logged in as expert login.T2S 
ETH when used as a standalone 
communication card; it supports 
only SNMP V1. When T2S ETH is 
connected to Inview X Display, 
then user can configure SNMPV2C 
and SNMPV3.

For configuration refer to section 
“SNMP”, page 39.

7.6.10.4	 Modbus

	• Modbus

Modbus RTU configuration can 
be done from T2S ETH web 
page when logged in as expert 
login.T2S ETH when used as a 
standalone communication card; 
it supports only Modbus RTU. 

NOTE! Modbus TCP/IP can be accessed 
and configured through Inview X only.

For configuration refer to the 
sections “Modbus”, page 76 
and “Modbus over RTU”, page 
90.
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7.6.10.5	 Power

	• General

Redundancy: The number of 
redundant modules can be set for 
each output phase.

Source power ratio DC vs. AC: 
percentage of power fed by DC. 
By default, this parameter is set 
to 0.  
0% - Only AC source (EPC mode), 
100% - Only DC source (On-line 
mode).

Battery test: enable it to test the 
battery while the system is in 
live condition. (Before enabling 
the test, make sure to label as 
“Battery Test” and set the logic 
selection in Inputs/Relay page. 

Battery test src pow ratio: set the percentage of load sharing from the DC during the battery test. For example, 
if the value is 70%, the load sharing will be 70% from DC and 30% from the AC source.

Booster 10x Iin: enable the boost (see the manual of power module used for information on this feature).

AC In grid feed Disable: enable this feature, if “Booster.” 

	• AC In

Threshold values for module 
operation on the AC input side. 
User shall modify it ONLY if he 
has followed a proper training by 
CE+T.

Note: To know more about each 
field, refer to “AC In”, page 78.
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	• DC Group

User can configure the DC input as per the number of battery bank installed.

Maximum two DC groups can be 
configured. First column for DC 1 
and second column for DC 2. 

By default, both columns will 
have default battery parameters. 
User can modify according to the 
installed battery bank.

Note: Two columns are for A+B 
Rectifier DC Plants. When only 
one DC Plant is used, the second 
column is not applicable. To know 
more about each field, refer to “DC 
Group”, page 79.

	• AC Out

Phase shift & Vout for each 
phase: define phase shift between 
phase.

Nominal Freq: nominal frequency 
50 or 60 Hz.

Nb of phases: Number of phase 
single or three phase.

Short circuit voltage & hold time: 
short circuit hold time before shut 
down 10 to 600 seconds (default 
60).

Max power/current derating.

Max overload duration.

Saturation Threshold: Saturation 
level (default 80%) generate alarm 
if AC output power exceed 80% of the total installed power.

Delta mode: operation mode delta for 3 phase configuration only.

Note: To know more about each field, refer to “AC Out”, page 79.
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	• Synchronization

Synchronization parameters are 
used to configure in the higher 
capacity system (> 32 inverter 
modules) by using TUS. 

TUS is a synchronization kit.

Note: To know more about each 
field, refer to “Synchronization”, 
page 80.

	• Other

 � Remote OFF disable AC 
power.

 � Walk in mode time.

 � Airco mode.

 � Force start without T2S.

 � No power from AC IN 
phase 1

 � No power from AC IN 
phase 2

 � No power from AC IN 
phase 3

Note: To know more about each field, 
refer to “Other”, page 81

7.6.10.6	 Info

	• T2S-ETH

This tab provides information 
about the T2S ETH:

 � Serial Number

 � Software version

 � Interface version

 � Bootloader version

 � MAC Address: In case 
of required support, it’s 
mandatory to provide 
information listed in this 
page or a screenshot of it.



8.	SNMP

8.1	 SNMP Configuration via T2S ETH

8.1.1	 Introduction

This document describes the Management Information Base (MIB) schema design for standalone T2S ETH for SNMPv1 
configuration and T2S ETH with Inview X for SNMP V2C and V3 configuration. A MIB schema describes the structure of 
information served by a Simple Network Management Protocol Subsystem (SNMP) agent.

8.1.2	 General NMS, SNMP Agent and MIB Role

This section describes the Management Information Base’s (MIB’s) and SNMP Agent’s roles.

8.1.2.1	 NMS Role

SNMP’s purpose is to report operational status information about networked computing devices to a centralized 
Network Management System (NMS) endpoint. The status information is typically polled from an SNMP Agent on 
regular intervals by a Network Management System (NMS) Endpoint. The SNMP Agent can also check internal status at 
regular intervals, and when status of certain metrics falls outside pre-defined acceptable tolerances, an asynchronous 
Notification is transmitted to the NMS. This notification is termed as a Trap. 

8.1.2.2	 MIB Role

The MIB file describes the specific format of data provided by the SNMP agent running within the subsystem.  The data 
is grouped in terms of high-level objects and therefore models a top-down hierarchical design. There exist a high-level 
object defined in a TOP LEVEL MIB file; they are CET-TSI-MIB and CET-TSI-SMI 

8.1.2.3	 SNMP Agent Role

An agent is a network-management software module that resides on a managed device. An agent has local knowledge 
of management information and translates that information to or from an SNMP-specific form. A network management 
station (NMS) executes applications that monitor and control managed devices. As mentioned above, the SNMP agent’s 
purpose is reporting data elements to a Network Management System tool, such as MG Soft, I reasoning on a periodic 
basis.  Also, if the system is exhibiting non-ideal behavior, Notifications can be distributed to the NMS on a per incident 
basis called the Traps. After Notifications that denote non-conforming or malfunctioning behavior are triggered, the 
system may further distribute Notifications indicating the system is back to its normal state.  

8.1.3	 MIB General Design

This section describes the general design for the T2S ETH and Inview X products

8.1.3.1	 Industry Identification

The private CET MIB shall be represented by the object identifier 1.3.6.1.4.1.12551, or iso.org.dod.internet.private.
enterprise.cetMIB.

The TSI MIB shall be named cetTSI and will be located as a child object of the cetMIB, using object identifier 
1.3.6.1.4.1.12551.4, taking the next available spot at the top level of the cet MIB’s Products node.
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8.1.3.2	 MIB Design in the T2S ETH and Inview X Products

Each component in the system or device shall be monitored, and therefore will be described by its own Management 
Information Base (MIB) structure file, which describes the data provided by that MIB. The data elements in a MIB are 
grouped in objects, and each object may hold any number of child objects specified as either scalar values or tabular 
values.

In CET-TSI MIB Device objects are grouped to a high level table tsiObjects, a Table is effectively specified as a group 
of scalar values each scalar is a column in the table.  Tables are used to provide multiple groups of information 
(multiple rows).The first child of tsiObjects are tsiModules,tsiPhases, tsiACGroups, tsiDcGroups, tsiAlarms, tsiTraps, 
tsiEventDescription, tsiT2SInfo, tsiConfiguration

For example, tsiModules is the table which holds all module information; if there are multiple Module components on a 
given system, the tsiModuleseen MIB table will provide an instance (row) for each module like tsiModuleSeen.1 (.1) is 
the instance referring to the first module.

Inview X provides Inview specific MIB. Customer can download this MIB from Inview. Refer to “8.2.2 MIB”, page 43 

8.1.4	 SNMP V1 Configuration

SNMP version 1: the oldest flavor.  Easy to set up - only requires a plaintext community. A community string sent in 
plaintext, possibly from a restricted range of allowed IP addresses, is as good as the security gets. 

8.1.4.1	 T2S ETH web 

SNMP configuration can be done from T2S ETH web page when logged in as expert login.T2S ETH when used as a 
standalone communication card; it only supports SNMP V1. When T2S ETH is connected to Inview X Display, then the 
user can configure SNMPV2C and SNMPV3.

8.1.4.2	 Network Configurations for T2S ETH Standalone

1.	 Login to T2S web link http://192.168.0.2/index.html as Expert login.

2.	 Click “Parameters” button in the toolbar.

3.	 Go to “Monitoring” tab and click “Network”.

4.	 In Connection mode the “Hardware setup” should be Standalone.

5.	 If you are on a network with DHCP, you can enable the DHCP inside the Network submenu of the “Monitoring” 
menu.

6.	 Turn DHCP to “Enable”.

7.	 Click “Save”.
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8.	 When DHCP is enabled IP to T2S will be assigned by the DHCP server or the Router to which T2S ETH is 
connected. 

9.	 To find the IP address of T2S ETH card IP Scanner tools can be used.

10.	Refer section 8.3, page 43 for more information.

11.	If DHCP status is “Disable”.

12.	Configure Network

13.	If your Trap receiver is a server with host name, then configure DNS if you want your trap to be received.

8.1.4.3	 SNMP V1 agent configuration

1.	 Once your network is ready, you can configure the SNMP server, and the TRAP 

2.	 Click “Parameters” button in the toolbar.

3.	 Click “SNMP” tab.

4.	 As mentioned earlier, T2S ETH standalone card supports only SNMP V1 configuration, here you can select only 
SNMP V1. Ignore SNMP V2C and SNMP V3 from the drop down list and these configurations will not communicate 
with T2S ETH card.

5.	 SNMP Port is configurable through Expert login 
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6.	 SNMP Port number is standard port 161 for V1 communication

7.	 SNMP V1 will not communicate when port number is changed from default port number even if the same port 
number is configured at the NMS end.

8.	 SNMP Agent Community is configurable, the same agent community name has to be used in NMS SNMP V1 
profile.

9.	 Community name accepts a maximum of 15 ASCII characters.

8.1.4.4	 SNMP V1 trap settings

1.	 Port Trap Chooses the port on which the trap is send and default port is port 162

2.	 Traps will not be received if the port number is changed.

3.	 Choose SNMP Version V1 as T2S ETH only supports SNMP V1 communication.

4.	 Community for V1 traps can be ignored as V1 traps does not consider community name. 

5.	 Trap version for T2S ETH is CET MIB Traps

6.	 Traps will not be received when UPS MIB Traps are selected.

8.2	 SNMP Configuration via Inview X

8.2.1	 SNMPV1, V2 and SNMPv3 configuration

For the SNMP configuration via Inview X web UI, go to Advanced View > Site > Configuration, scroll down to the SNMP 
Agent section and select the following options.

	• In the ID CF61, select “True” to enable the SNMP function and enter the port address in the ID CF62.

	• In the ID CF63, select the SNMP version V1, V2c and V3.
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	• In the ID CF611, enter the Trap Targets IP.

8.2.2	 MIB

This section describes the Inview Management Information Base (MIB) schema design for SNMP V1, V2c and V3 
configuration. A MIB schema describes the structure of information served by a Simple Network Management Protocol 
Subsystem (SNMP) agent. 

The data is grouped in terms of high-level objects and therefore models a top-down hierarchical design. 

To download the SNMP MIB file, go to Administration > Files > MMI References and click SNMP MIB “Export” button.

8.3	 Advanced IP Scanner
This section helps you identify your T2S ETH IP when DHCP is enabled. Advanced IP Scanner open-source software 
is available in online, and this application needs not be installed in local machine. It is a reliable and free network 
scanner to analyze LAN. The program shows all network devices, gives you access to shared folders, and provides 
remote control of computers.

Download the application from https://www.advanced-ip-scanner.com

Run the .exe file when the application opens, click on RUN scan.
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8.4	 SNMP V1 Testing
This section helps you to test the SNMP of your T2S ETH unit. There are several different software programs (some are 
free) is available online to download. Current example is given using “iReasoning MIB Browser”.

Here are the steps to follow:

1.	 Click File > Load MIBs and browse to locate on your hard drive, where the files downloaded on my.cet-power.
com portal (CET-TSI-MIB.mib & CET-TSI-SMI.mib).

2.	 Once it is done, you can browse the MIB content under  
MIB Tree > iso.org.dod.internet > private > enterprises > cetMIB > cetTSIMIB

3.	 Fill the address field with your unit IP address.

SNMP
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4.	 Click “advanced” if you changed settings like Read Community.

5.	 Select the operation, for example “WALK” and click “Go”.

6.	 The result looks like

SNMP
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8.5	 SNMP V1 Traps
To check the SNMP V1 traps, 

1.	 Click Tools > Trap Receiver on the menu bar.

2.	 You should have defined the IP address of the laptop running MIB Browser in the T2S ETH configuration in order 
to retrieve trap.

8.6	 SNMP V3 Testing
Snmpb-0.8.exe is the latest version of snmp tool. Download the file from this URL https://sourceforge.net/projects/
snmpb/ and run the exe to install the application.

8.6.1	 Steps to Load CET MIB

1.	 Open the application and navigate to editor.

2.	 Open CET-TSI-MIB and paste it in the editor.

3.	 Press Ctrl + S to save the file with the same file name.

4.	 Open CET-TSI-SIM and paste it in the editor.

SNMP
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5.	 Press Ctrl + S to save the file with the same file name.

6.	 Navigate to Modules Tab.

7.	 Check CET-TSI-MIB and CET-TSI-SIM are listed under available MIB Modules.

8.	 Select the above files and Press right arrow to move the files to Loaded MIB Module.

9.	 By doing this CET MIB files are loaded to SNMPB MIB tree.

10.	Navigate to tree tab and check for CET MIB under iso-org-dod-internet-private-enterprises-cetMIB.

SNMP
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8.6.2	 Steps to Load Inview MIB

1.	 Go to Inview Web UI, select ‘Advanced View’ and click the Settings icon.

2.	 Click on ‘MMI References’ and click on ‘Export’ button under ‘Generate SNMP MIB’ option.

3.	 Save the file in your computer.

4.	 Open the snmpb application and navigate to editor.

SNMP
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5.	 Open the downloaded MIB file, copy the content and paste it in the editor.

6.	 Press Ctrl + S to save the file with the same file name.

7.	 Navigate to Modules Tab.

8.	 Check if ‘CetCompas.mib’ is listed under available MIB Modules.

SNMP
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9.	 Select the file and Press right arrow to move the it to Loaded MIB Modules window.

10.	By doing this CET MIB files are loaded to SNMPB MIB tree.

SNMP
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11.	Navigate to tree tab and check for CET MIB under iso-org-dod-internet-private-enterprises-cet-siteMonitoring.

8.6.3	 Steps to Discover Device

1.	 Navigate to Discovery tab.

2.	 Select IP option and enter From and To IP addresses, this would be the IP address range of T2S ETH IP.

3.	 SNMP Agent profile to be selected based on the type of SNMP communication.

4.	 Click on discover device.

5.	 T2S device will be discovered.

6.	 Right click on the device and add device to agent profile list.

SNMP
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8.6.4	 Steps to Get / Walk OID

1.	 Select the SNMP Agent under remote SNMP agent.

2.	 The Added SNMP Agent has to be listed in the list.

3.	 Right click on the OID to perform walk or Get.

8.6.5	 Steps to add SNMP V3 User

1.	 Navigate to Options – manage Agent Profile.

2.	 Select the Agent Profile and select the supported SNMP Version.

3.	 Select Manage SNMP3 USM User.

4.	 Right click on User profile and add new user profile.

5.	 Security username should be the Priv user name given in T2S ETH web page.

6.	 Authentication protocol, Authentication password,  Privacy Protocol and Privacy password should also match with 
the values given in T2S ETH web page.

7.	 Click OK.

8.	 Navigate to Options – manage Agent Profile.

9.	 Select SNMP agent and select SNMP v3, under SNMP properties security name drop down list select the USM 
user created.

10.	Select Security level NoAuth/NoPriv or Auth/NoPriv or AuthPriv as the once configured in T2S ETH web page.

11.	Enter SNMP content text same as in T2S ETH web page.

SNMP
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8.7	 Reading alarms in SNMP
This section helps you to read Alarms in SNMP from your T2S ETH unit using CET MIB file. All Alarm related information 
are available under tsiAlarms, which is located at OID 1.3.6.1.4.1.12551.4.1.5.

The number of alarms ongoing in the system could be retrieved from following OID in this section:

	• tsiNbMinorAlarm (OID 1.3.6.1.4.1.12551.4.1.5.1) gives the count of active minor alarms in the system

	• tsiNbMajorAlarm (OID 1.3.6.1.4.1.12551.4.1.5.2) gives the count of active major alarms in the system

	• tsiTotalAlarmNumber (OID 1.3.6.1.4.1.12551.4.1.5.3) gives the count of all active alarms in the system

The tsiAlarmTable (OID 1.3.6.1.4.1.12551.4.1.5.4) is the child table under tsiAlarms, which has details of all the active 
alarms in the system. When an event or an alarm is published in the T2S ETH user interface, the same active alarm list 
will be seen in the Alarm table in SNMP (i.e) event occurred first will be last in the table and the recent event will be on 
the top of the table. A maximum of 50 Alarms are captured in SNMP like in T2S ETH user interface.

Each entry in this table has the following objects:

	• tsiAlarmIndex

	• tsiAlarmID

	• tsiAlarmType

	• tsiAlarmSource

	• tsiAlarmDescription

	• tsiAlarmTime 

tsiAlarmIndex (OID 1.3.6.1.4.1.12551.4.1.5.4.1.1)

It captures the index of active alarms, like the ID of the row in the table.

tsiAlarmID (OID 1.3.6.1.4.1.12551.4.1.5.4.1.2)

It will list the ID’s of Each active Alarm. Alarm ID list is available in section “Annex 1: Supervisor alarms - T2S ETH”, 
page 65 and “Annex 2: Module alarms - T2S ETH”, page 67. 

Example: Alarm is Source V Too Low Stop has the ID 179. When we get this alarm, 179 will be read from tsiAlarmID.1 
in that entry.

tsiAlarmType (OID 1.3.6.1.4.1.12551.4.1.5.4.1.3) 

It provides the severity of the alarm. When an alarm is configured as event Alarmtype would be displayed as noAlarm 
(0) in SNMP. Alarm type can be either: 

	• noAlarm (0)

	• minor (1)

	• major(2)

Example: tsiAlarmType.1 minor(1) as Source V Too Low Stop is configured as Minor Alarm

SNMP
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tsiAlarmSource (OID 1.3.6.1.4.1.12551.4.1.5.4.1.4)

It will list the source of the generated alarm. There are three different alarm sources: t2s (monitoring), Module and 
System. Values are given below:

	• t2s(0), 

	• module01(1), module02(2), … until module32(32)

	• system(33)

tsiAlarmDescription (OID 1.3.6.1.4.1.12551.4.1.5.4.1.5) 

It is the event string of the alarms available in your system.

Example: 

	• tsiAlarmDescription.1 Source V Too Low Stop

	• tsiAlarmDescription.2 Output Failure

	• tsiAlarmDescription.3 Output Fault

tsiAlarmTime (OID 1.3.6.1.4.1.12551.4.1.5.4.1.6) 

It gives you the information of time stamp of when the alarm was generated.

Example

In the following sequence, we explain how the Index of the Alarm change when a new alarm occurs and provides an 
example for each field of many entries.

1.  The Alarm Index of Alarm output fault is 1.

Instance tsiAlarmIndex tsiAlarmID tsiAlarmType tsiAlarmSource tsiAlarmDescription tsiAlarmTime

1 1 275 noAlarm(0) system(33) Output Fault
2020-3-16, 
23:44:39

2 2 7 minor(1) system(33) Too Many Starts
2020-3-16, 
23:44:39

3 3 268 major(2) system(33) Output Failure
2020-3-16, 
23:44:33

2.  A new alarm Manual or Remote Off new added to the list. Now the Alarm Index of Output fault is 2 and Manual or 
Remote off is 1.

Instance tsiAlarmIndex tsiAlarmID tsiAlarmType tsiAlarmSource tsiAlarmDescription tsiAlarmTime

1 1 274 noAlarm(0) module01(1) Manual or Remote Off
2020-3-18, 

6:41:29

2 2 275 noAlarm(0) system(33) Output Fault
2020-3-16, 
23:44:39

3 3 7 minor(1) system(33) Too Many Starts
2020-3-16, 
23:44:39

4 4 268 major(2) system(33) Output Failure
2020-3-

16,23:44:33
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3.  DC Source Low is the new alarm in the list. Which takes the Alarm index 1 and rest follows.

Instance tsiAlarmIndex tsiAlarmID tsiAlarmType tsiAlarmSource tsiAlarmDescription tsiAlarmTime

1 1 265 major(2) system(33) DC Source Low
2020-3-
18,6:43

2 2 274 noAlarm(0) module01(1) Manual or Remote Off
2020-3-

18,6:41:29

3 3 275 noAlarm(0) system(33) Output Fault
2020-3-

16,23:44:39

4 4 7 minor(1) system(33) Too Many Starts
2020-3-

16,23:44:39

5 5 268 major(2) system(33) Output Failure
2020-3-

16,23:44:33
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9.	 ModBus TCP/IP via Inview X
Modbus over TCP/IP is available in read mode, which means that Modbus can be used for monitoring the system.

Port is fixed to standard Modbus TCP/IP port 502. This protocol can be either enabled or disabled.

For the Modbus configuration, go to Advanced View > Site > Configuration, scroll down to the Modbus section and

select the following options.

In the ID CF155, select “True” to enable the Modbus TCP/IP function.

The following device/equipment mapping has been defined:

Device ID Equipment

11 Inverter System 1

91 Energy System 1

100 Site

When the equipment does not exist, it will respond with function code 4.

	• Each discrete input is associated with the alarm of the equipment, with the same id. Reading 1 means that the 
alarm is active.

	• Each input register corresponds to the data of the equipment. All these values are coded assigned 16 bit. A 
correction factor is often applied. All the values are not available (like strings. Some status are coded as uint)

	• Each discrete coil corresponds to the entries for controlling the equipment. It supports only simple control, 
without any parameters.

	• Each holding register corresponds to the configuration of the equipment. It only supports entries that can be read 
and of numeric type. It includes advanced controls with parameters, complimentary with discrete coils.

The Modbus transport layer is Ethernet over TCP/IP. The default used port is 502:

	• Discrete Inputs, alarm reading (Read Only), using modbus command 01 

	• Input Registers, data reading (Read Only), using modbus command 03

If you want to use Modbus to monitor other types of systems, please contact us. We will study the business case and 
make a proposal.
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To download the Modbus data, log in to the Inview web interface, go to Administration > Files > MMI References and 
click the Modbus Map “Export” button.
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10.	 FAQ
1.	 I am unable to change the output phase of a module?

 � Check that the number of phases is correctly configured in Configuration > Power > AC OUT > Nb of 
phase.

 � Module should be manually turned off (module page).

 � Don’t forget to turn the module back on when the phase is changed. 

2.	 I want to replace a power module in my system. What should I do?

 � Remove the module

 � Browse to module selection pop-up.

 � The removed module appears in red. Click on it. 

 � This brings you to module page. Uninstall the module by clicking the uninstall button.

 � Insert the new module.

 � Module will appears on module selection pop-up.

 � Its address can be changed by browsing to module page. 

3.	 How can I reset my admin password if I have unfortunately forgotten it?

In case of password lost, a new temporary password (valid 24 hrs after creation) can be issued by CE+T Power. 
To receive a temporary password, send an email with your T2S ETH serial Number and the date at which you 
expect to go back on site to change the password to customer.support@cet-power.com specifically requesting 
a new temporary password. The serial number can be found on the sticker on the T2S ETH, or on screen in 
“Parameters” then “Info”.

4.	 What is the purpose of the SNMP trap community?

T2S ETH device features the ability to send SNMP Trap events to a configured SNMP trap receiver. This could be 
Test Traps and Traps sent when there is an alarm.

These traps receivers can be configured in T2S ETH web page under parameters -> SNMP -> Trap receiver in 
Expert Login.

 FAQ
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A maximum of 5 Trap receivers can be configured in T2S ETH.

The purpose of SNMP trap community string:

	• This is an added measure of security, operators may configure a trap community string which is used by the trap 
receiver to determine which traps are to be accepted from a device.

	• This parameter is useful to avoid unwanted floods of Traps from a malicious source, by configuring Trap 
community string only relevant traps are processed by the trap receiver.

	• Filtering on Trap Community string is used to process relevant Traps.

5.	 How the DC flow indicator is managed in the user interface of T2S ETH (& Inview X)? 

The DC Flow indicator depends on the system Configured power (W) and DC Input power (W). 

The DC flow will stop when DC Input power (W) is Less than 5 % of Configured System power (W). The minimum 
DC Input Power must be at least 5% of the configured power in the system to be shown; this is to prevent a lack 
of accuracy of converters measures when the system is almost not loaded.
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11.	Trouble Shooting and Defective Situations Fixing

11.1	 Defective T2S ETH

11.1.1	 Return defective T2S interface 

A T2S totally dark (indication area) or that cannot interface with your laptop are evidence of failure. 

11.1.2	 Return defective T2S ETH

	• A repair request should follow the regular logistics chain:  
End-user => Distributor => CE+T Power.

	• �Before returning a defective product, a RMA number must be requested through the http://my.cet-power.com 
extranet. Repair registering guidelines may be requested by email at repair@cet-power.com.

	• �The RMA number should be mentioned on all shipping documents related to the repair.

	• �Be aware that products shipped back to CE+T Power without being registered first will not be treated with high 
priority!

	•  Information on failure occurrence as well as module status in “Events” page shall be attached to defective unit 
return package or recorded in RMA.

Trouble Shooting and Defective Situations Fixing
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12.	 Service
For Service 

	• Check Service Level Agreement (SLA) of your vendor. Most of the time they provide assistance on call with 
integrated service. If such SLA is in place, you must call their assistance first.

	• If your vendor doesn’t provide such assistance (*) you may call CE+T directly. Toll free Number 1(855) 669 - 
4627(**), or log your tickets in - https://my.cet-power.com/mportal/request_technical_support.asp.

Service is available from 8:00 A.M. to 10:00 P.M. EST, Monday through Friday, except closing periods for holidays or 
inclement weather.

Major Incidents and Emergency conditions can be invoked for immediate handling of same number or by dropping a 
mail on customer.support@cetamerica.com (***) 

(*)	  CE+T will redirect your call to your vendor if he has such SLA in place.

(**)	 Valid in USA and Canada only.

(***)	 Messages that are not Major Incident or Emergency will be served at the next scheduled working a day.	  
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13.	 Maintenance Task
As maintenance will perform on live system, all task should perform only by trained people with sufficient knowledge 
on TSI and ECI product.

Tasks:

	• Identify the site, customer, responsible, cabinet number, product type.

	• Download and save configuration file for back up.

	• Check configuration file to be in accordance with operational site conditions.

	• Read and save log file for back up.

	• Check and analyze log file, and if alarm are present.

	• Replace dust filter if present. Filter is mandatory in dusty environment.

	• Check module temperature and log value. If the internal temperature is higher than the previous year, determine 
if this is due to increased load, accumulated dust or reduced airflow. It is common to have a delta of 15°C by 
30% of the load between the ambient and the internal temperature. If temperature increases due to internal dust 
built up, clean the module by air suction blower or vacuum cleaner.

	• Clean cabinet (vacuum cleaner or dry cloth)

	• Control the inverter mapping (AC Group, DC Group, Address)

	• Check load level and record the rate value (print in word document the 4 screen modules information for the 32 
modules, the 3 screen for the phases value and the 2 screens for the group AC and DC value)

	• Change the configuration file for AC and DC mix mode to check that all TSI work on both power supply

	• Check alarm operation (e.g., redundancy lost, mains failure, DC failure) on dry contact and through SNMP system 
or web interface.

	• Switch OFF AC IN and check alarms.

	• Check temperature terminal and temperature wiring. If possible use an infrared camera.

	• Read and record value as wave form, power factor, Crest factor, THD I from power analyzer.

	• Take cabinet picture

	• Keep track of report and provide end user with a copy.

	• Perform a MBP procedure. This task is not really recommended*, but could be demanded by site manager. 

* It is not recommended because when you perform a By-pass procedure, generally there is no back up on AC input 
line, and the load shutdown if mains disappear.
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14.	 Annex 1: Supervisor alarms - T2S ETH
This is the list of alarms issued by the supervisor. Other alarms are issued by other modules (see section 15, page 
67). The supervisor is able to generate alarms that are related to the system, to inverter modules, or to itself. Alarms 
related to inverters will be seen as system alarms when module alarm is present on all inverters. 

Each alarm has a priority level. The level can be (disabled, event, minor, major). If the level can be configured in the 
user interface, then it is marked as “mappable”.

System Alarms

Text ID Name Level
Default 
Mapping

Description

256 MBP Engaged mappable major

When the Inverter system operates in bypass mode, T2S 
ETH will display the alarm by using auxiliary contact from 
MBP switch through Digital input 1.  
Digital input 1 is dedicated to MBP if it is installed in the 
system.

257 Surge Arrester mappable minor

In the inverter system, if surge arrester fails, T2S ETH will 
display the alarm by using auxiliary contact from surge 
arrester through Digital input 2.  
Digital input 2 is dedicated to surge arrester if it is 
installed in the system.

258 Redundancy Lost mappable minor
It is a lost of inverter redundancy. Redundancy is 
configured, and redundancy is lost on any output group.

259 Redundancy +1 Lost mappable minor
It is a lost of inverter redundancy + 1 inverter. 
Redundancy is configured and more than redundancy is 
lost on any output group.

260 Main Source Lost mappable major

Priority source is lost ( depend on the configuration EPC 
or Online). Any of the groups from the main source does 
not conform. Example: there are 3 AC input groups, 
and the AC source is the main source. If one AC input is 
offline, the alarm is triggered.

261 Secondary Source Lost mappable minor
Secondary source is lost ( depend on the configuration 
EPC or Online) Any of the groups from secondary source 
does not conform.

262 AC Source Lost mappable R3 Any AC input group does not conform.

263 DC Source Lost mappable disabled Any DC input group does not conform.

264 AC Source Not Sync mappable minor
Any AC input group is not synchronized with AC output or 
has an out of range frequency.

265 DC Source Low mappable major
Check Vdc parameter and live value. Any DC input group 
has a voltage lower that defined threshold.

266 Output Saturated mappable disabled
The load on any output group is higher than the 
saturation threshold (80% of configured output power).

267 Output Overloaded mappable major
The load on any output group is higher than the 
configured output power.

268 Output Failure mappable major
Any output group has 0 seen modules, or no module 
running (and they are not manually off).

269 System Started event System just started.
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System Alarms

Text ID Name Level
Default 
Mapping

Description

272 Missing Module event
Module is removed or defect. No module is detected on 
system bus.

273 New Module event All modules have just been detected on system bus.

274 Manually OFF mappable disabled
Inverter are switched OFF by the OFF function in hyper 
terminal. All modules outputs are manually turned off.

275 Output Fault event All modules outputs are turned off because of a fault.

276 Brownout Derating event
AC in below threshold -  reduce power from the AC input 
and pulls power form the DC input. All modules AC inputs 
are derated because of a brown-out.

278 Temperature Derating event
Heat sink temperature is over rating. All modules outputs 
are derated because of an over temperature.

279 Overtemperature event
Temperature is too high in the room or bad cooling, or 
component defective inside inverter. All modules outputs 
are turned off because of an over temperature.

Supervisor T2S ETH Alarms

Text ID Name Level Def. Map Description

512 Digital Input 1 mappable disabled
Digital input 1 is in low state and digital input 1 is NOT 
used for MBP signaling.

513 Digital Input 2 mappable disabled
Digital input 2 is in low state and digital input 2 is NOT 
used for surge arrester signaling.

514 Log Nearly Full mappable disabled Log file is nearly full.

515 Log Full mappable disabled Log file is full (with information loss).

516 Log Cleared event Log file has just been cleared.

517 Config modified event Configuration has just been modified.
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15.	 Annex 2: Module alarms - T2S ETH
Module not Recoverable Alarms

Text ID Name Level Def. Map Check and Action

1 Fan Failure Minor Fan replacement

2 Permanent Fault (2) Minor

3 Permanent Fault (3) Minor

4 Permanent Fault (4) Minor

5 Permanent Fault (5) Minor

6 Permanent Fault (6) Minor

7 Too Many Starts Minor
To clear the alarm, either increase the AC input voltage 
hysteresis or turn OFF the module and turn ON the 
module through the web interface or remote ON/OFF.

8 Permanent Fault (8) Minor

9 Permanent Fault (9) Minor

10 Permanent Fault (10) Minor

11 Permanent Fault (11) Minor

12 Permanent Fault (12) Minor

13 Output Polarity Minor

14 Overload Too Long Minor Check load condition

15 Output Fuse Minor

16 Permanent Fault (16) Minor

18 Permanent Fault (18) Minor

19 Permanent Fault (19) Minor

28 Permanent Fault (28) Minor

29 Permanent Fault (29) Minor

30 Permanent Fault (30) Minor

31 Permanent Fault (31) Minor

32 Permanent Fault (32) Minor

Module Recoverable Alarms

Text ID Name Level Def. Map Check and Action

33 Output Synchronization Minor Check frequency TSI and Mains

34 Temperature Too High Minor Check temperature inside inverter

35 Com. Bus Failure Minor
T2S bus failure or no T2S seen. TSI blinks red - hardware 
problem

36 Com. Bus Conflict Minor When two TSI have the same ADX - will self repair

37 No Power Source Minor No input AC and inout DC availlable 

38 Com. Bus Failure Minor TSI has not started must have a T2S - orange LED

39 Parameter Query   Minor Inverter is updating his parameters

40 Parameter Mismatch Minor Parameters incompatible with configuration file
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Module Recoverable Alarms

Text ID Name Level Def. Map Check and Action

41 Parameter Not Ready Minor Check AC, configuration and allocated phases

42 Recoverable Fault (42) Minor

43 Inv Mismatch Minor
Inverter incompatible with inverter installed in system 
(pack with “a la carte”)

44 Backfeed Error  Minor Inverter OFF due backfeed error

45 Recoverable Fault (45) Minor

46 Ext. Clock Fault Minor System OFF due external clock failure

47 Overload Triangle Minor Inverter OFF due internal failure

Module Alarms

Text ID Name Level Def. Map Check and Action

65 TSI Com. Bus Failure Minor synchronization problem

66 T2S Com. Bus Failure Minor
problem will be stored in internal black box- return for 
investigation

67 TSI Com. Bus Failure Minor cabling or module problem

68 T2S Com. Bus Failure Minor
Problem will be stored in internal black box- return for 
investigation

69 Recoverable Fault (69) Minor

70 Recoverable Fault (70) Minor

71 Output Volt. Changing Minor
Happens when there is a config change to the voltage- 
lasts 1 min for a change from 100V to 120V - never insert 
a new module while this is happening!

72 Output Overload (I) Minor Check load condition

73 Com. Bus Mismatch Minor
Alarm- triggered when it sees more or less modules on 
bus A vs bus B - used to identify a module problem while 
the module is still running - module needs to be replaced

74 Imminent Start Minor
reported from a stopped module 10 seconds before it is 
going to start

75 Booster Not Ready Minor Wait 1 minute to recover the situation

76 Overload Not Ready Minor Wait 1 minute to recover the situation

77 Temperature Derating Minor
temperature measured from the heat sink - 88C for bravo 
and 70C for media

78 Output Overload (P) Minor Check load condition

79
Recoverable  
Fault (79)

Minor

80 Brownout Derating Minor
AC in below 180V -  reduce power from the AC input and 
pulls power form the DC input

81 Fan Life Minor
Write an event “FAN LIFE ELAPSED” in log file when the 
counter elapsed time is reach for one inverter.

82 Remote Off Minor
Write an event “REMOTE OFF” in log file when inverter is 
set OFF through REM ON/OFF terminal
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Module Alarms

Text ID Name Level Def. Map Check and Action

83 Manual Off Minor
Write an event “MANUALLY OFF” in log file when module 
is set OFF through hyperterminal

84 Triangle Off Minor Inverter in OFF position due triangle mode failure

85
Recoverable  
Fault (85)

Minor

86
Recoverable  
Fault (86)

Minor

88
Recoverable  
Fault (88)

Minor

Module AC Input Alarms

Text ID Name Level Def. Map Check and Action

160 Ok No error on AC IN

161
Source V Too Low 
Transfert

Minor Check AC IN configuration and live value

162
Source V Too High 
Transfert

Minor Check AC IN configuration and live value

163 Error (163) Minor

164 Error (164) Minor

165
Source V Too Low 
Transfert

Minor Check AC IN configuration and live value

166
Source V Too High 
Transfert

Minor Check AC IN configuration and live value

167 Source Not conform Minor Check AC IN configuration and live value

168 Source Not conform Minor Check AC IN configuration and live value

169 Source Not conform Minor Check AC IN configuration and live value

170 Power Disabled Minor AC input converter is only use for synchronization

171 Source Not conform Minor Check AC IN configuration and live value

172 THD Too High Minor Check AC IN configuration and live value

173 Output Synchronization Minor Check AC IN configuration and live value

174 Error (174) Minor

175 Output Synchronization Minor Check synchronization between AC IN and AC OUT

176 Inv. Synchronization Minor Check synchronization between AC IN and AC OUT

177 Synchronization failure Minor Check synchronization between AC IN and AC OUT

179 Source V Too Low Stop Minor Check AC IN configuration and live value

180 Source V Too High Stop Minor Check AC IN configuration and live value

181 Source Frequ. Too Low Minor Check AC IN configuration and live value

182 Source Frequ. Too High Minor Check AC IN configuration and live value

183 Phase Not Ready Minor Check AC IN configuration and live value

184 Backfeed Error Minor Inverter in backfeed protection
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Module AC Input Alarms

Text ID Name Level Def. Map Check and Action

188 Error (188) Minor

189 Error (189) Minor

190 Error (190) Minor

191 Error (191) Minor

Module DC Input Alarms

Text ID Name Level Def. Map Check and Action

193 Ok No error on DC IN

194
Source V Too Low 
Transfert

Minor Check VDC parameter and live value

195
Source V Too High 
Transfert

Minor Check VDC parameter and live value

196 Error (196) Minor

202
Source V Too Low 
Transfert

Minor Check VDC parameter and live value

203
Source V Too High 
Transfert

Minor Check VDC parameter and live value

204 Source V Too Low Stop Minor Check VDC parameter and live value

210 Source V Too Low Stop Minor Check VDC parameter and live value

211 Source V Too High Stop Minor Check VDC parameter and live value

217 Error (217) Minor

220 Error (220) Minor
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16.	 Annex 3: Configuration parameters - T2S ETH

16.1	 Montioring
Disclaimer: The configuration file should be manually edited only by CE+T crew or any especially trained operator.  
All modifiable values contained here are easily accessible through the T2S ETH web interface which allow you to 
change the configuration carefully. Any mistake done in this file could lead to system malfunction and CE+T shall not 
guarantee the behavior of the whole system once this file has been corrupted.

•	 Time

Text ID Name Values Description

Time HH : MN : SS Set the Time in Hours : Minutes : Seconds

Date DD : MM : YY Set the Date in Day : Month : Year

•	 Regional settings

Text ID Name Values Description

Regional settings

525 Language

English

Select a language for User interfaceFrench

German

523 Sitename CE+T Enter the site name which will appear in user interface banner

524 Location Belgium Enter the location of the system installed.

562 Auto logout delay 1 - 6000 seconds The auto logout time for Expert login

561 Keyboard layout
azerty

Keyboard layout for Inview X touch screen
qwerty

631
New module  

identifier

Always ask Select a function to perform while inserting a new module.

•	 Always ask - System will ask to assign the address of every newly 
inserted module.

•	 Always replace - System will assign the address of the replaced 
module automatically. 

•	 Never replace - System will assign the module address randomly.

Always replace

Never replace

634 Home page

Classic homepage User interface display for home page. 

•	 Classic home page - Displays information of AC IN, DC IN, and AC OUT 
parameters, for more information user has to click Magnifier button.

•	 Alternate homepage - Displays brief information of parameters in 
single page without clicking Magnifier button. 

Alternate homepage

Display format

620 Date format

DD/MM/YYYY

Date format for user interface and user logYYYY/MM/DD

MM/DD/YYYY

621 Time format
24H

Time format for user interface and user log
12H
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Text ID Name Values Description

622
Temperature 

format
Celcius  °C

Temperature format for user interface and user log
Fahrenheit  °F

•	 NTP Server

Text ID Name Values Description

NTP server
Time to be synchronized with Global Time Zone Offset by using NTP 
server IP.

554
IP address of NTP 

server
0.0.0.0

Enter the NTP Server IP address. It is used to synchronize the clocks of 
the inverter system to local time.

555 Port 123 NTP server port

556 Timezone offset UTC-12 to UTC+12 UTC – Coordinated Universal Time, set your country UTC time zone.

557 Auto-refresh
Disable

Enable or disable the automatic synchronization to NTP server.
Enable

558
Synchronization 
interval (days)

Integer : 1 - 365
Interval in days between two automatic time synchronizations to NTP 
server.

•	 Passwords

Text ID Name Values Description

Passwords
Password is used for Expert login, the default password is “pass456”. It is 
recommended to change the password.

Password - Type your new password

Confirm Password - Re-type the same password

•	 Network

Text ID Name Values Description

Connection mode

627 Hardware setup

With Inview X

Select “With Inview X” option if monitoring device (Inview X) is installed 
in the system. In this option user can access the network connection 
through Inview X at rear. 

SNMP available version: v1, v2c and v3

Standalone

Select “Standalone” option if monitoring device (Inview X) is not installed. 
User can access the network connection from T2S ETH at front (Wait at 
least 3 minutes to establish connection). 

SNMP available version: v1

Network address

517 DHCP status

Disable Disable: It allows to configure static IP to T2S ETH card

Enable: IP to T2S will be assigned by the DHCP server or the Router to 
which T2S ETH is connected. To find the IP address of T2S ETH card IP 
Scanner tools can be used 

Enable

512 IP address 192.168.0.2
Default IP address is 192.168.0.2, user can set their own System IP 
address
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Text ID Name Values Description

513 Subnet mask 255.255.255.0 Enter the system subnet mask address

514 Default gateway 192.168.0.254 Enter the system default gateway address

515 Primary DNS 0.0.0.0 Enter the system Primary DNS address

516 Secondary DNS 0.0.0.0 Enter the system Secondary DNS address

•	 Alarms

Text ID Name Values Description

Alarms

552 MBP Configured
Disable Enable: If MBP switch is installed in the system and engaged, the alarm 

will generate through Digital Input 1.

Disable: If not installed, user can utilize the Digital Input 1 for other inputs.Enable

559 Remote MBP
Disable

Enable: If remote MBP is engaged, the alarm will generate through Digital 
Input 1 and relay 3 is connected to remote MBP unit.

Disable: If not installed, user can utilize the Digital Input 1 for other inputs.

(It is applicable only for the systems in USA market)Enable

553
Surge arrester  

configured

Disable Enable: If Surge arrested is installed and activated, the alarm will generate 
through Digital Input 2.

Disable: If not installed, user can utilize the Digital Input 2 for other inputs.Enable

538 Log full alarms
Disable If enabled, an alarm will be generated once it reaches the maximum limit. 

It is recommended to download the log files before it goes to FIFO.Enable

16.2	 Inputs/Relays

•	 Inputs Label

Text ID Name Values Description

Labels

521 Digital Input 1 MBP
By default the label is “MBP ENGAGED”. If MBP switch is not installed, 
user can define the name of their Digital Input 1.

522 Digital Input 2 Surge Arrester
By default the label is “Surge Arrester”. If Surge Arrester is not installed, 
user can define the name of their Digital Input 2.

•	 Relays Label

Text ID Name Values Description

Relays Label

535 Major Relay Name Major User label for major alarm relay and cannot be modified.

536 Minor Relay Name Minor User label for minor alarm relay and cannot be modified.

537 Relay 3 Name Relay 3
User can define the label name according to the selected alarm in Relays 
Mapping page.
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•	 Relays Delay

Text ID Name Values Description

Relays Delay

532 Major Relay delay

2 to 60 seconds
User can set the time (2 to 60s) for Relay to get energize after the alarm 
is generated.

533 Minor Relay delay

534 Relay 3 delay

•	 Relays Mapping

Text ID Name Values Description

Relays Mapping

543 MBP Engaged

Major

Minor

Relay 3

In this page, all the alarms from the modules and systems will be listed. 
User can set these alarms as major or minor. 

T2S ETH has one user selectable Alarm – Relay 3. It can be assigned any 
one alarm from the list.

549 Surge Arrester

545 Redundancy Lost

550 Redundancy +1 lost

563 Sync Redundancy Lost

564 All Sync Modules Lost 

580 Main Source Lost 

581 Secondary Source Lost 

539 AC Source Lost 

585 DC Source Lost 

546 AC Source Not Sync

586 DC Source Low

551 Output Saturated

544 Output Overload

540 Output Failure

590 System Manual Off

582 Missing Module

583 Module Manual Off

584 Module Output fault

589
Module Brownout 

Derating 

591
Module Temperature 

Derating

548
Module Over 
Temperature

541 Dig Input 1

542 Dig Input 2

587 Log Nearly Full

588 Log Full
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•	 Snmp traps

Text ID Name Values Description

General

543 MBP Engaged

Disable

Enable
If enabled, by using SNMP protocol these alarms can be used for TRAP 
receivers. ( number of TRAP receivers can set in SNMP page) 

549 Surge Arrester

545 Redundancy 

550
Redundancy +1 

lost

563
Sync Redundancy 

Lost

564
All Sync Modules 

Lost

580 Main Source Lost

581
Secondary Source 

Lost

539 AC Source Lost

585 DC Source Lost

546
AC Source Not 

Sync

Disable

Enable

If enabled, by using SNMP protocol these alarms can be used for TRAP 
receivers. (number of TRAP receivers can set in SNMP page) 

586 DC Source Low

551 Output Saturated

544 Output Overload

540 Output Failure

590
System Manual 

Off

582 Missing Module

583 Module Manual Off

584
Module Output 

fault

589
Module Brownout 

Derating

591
Module 

Temperature 
Derating

548
Module Over 
Temperature

541 Dig Input 1

542 Dig Input 2

587 Log Nearly Full

588 Log Full

633 Other alarms
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16.3	 SNMP

•	 SNMP

Text ID Name Values Description

SNMP settings

626 SNMP version v1  
Select the SNMP version 

•	 T2S ETH supports SNMP v1.

571 Port SNMP 161 The SNMP default value is 161 and should not modify it.

597
SNMPv1 Agent  

Community
public Set the community string for V1.

Trap Settings

572 Port Trap SNMP 162 Set the port to which SNMP trap are sent.

630 SNMP version v1 
Select  the SNMP version for traps sent by agent. V1 can be used in 
Stand-Alone mode.

629 Community v1 public Set the community string for traps in SNMP V1.

632 Traps version

0 : ‘No trap’

Select among the MIBs in T2S-ETH which one is allowed to send traps.1 : ‘CET MIB traps’

 2 : ‘UPS MIB traps’

Trap receivers

573 IP for trap 1

0.0.0.0 Set SNMP traps receiver IP.

574 IP for trap 2

575 IP for trap 3

576 IP for trap 4

577 IP for trap 5

16.4	 Modbus

•	 Modbus

Text ID Name Values Description

Inview X’s modbus TCP/IP

635 Port status
Enable Enable of ModBus TCP slave on Inview X. Available only through

Inview X.Disable

636 Port select 1 to 65535 Set port for ModBus TCP on Inview X.

Modbus RTU slave

566 RTU slave
Enable

Enable or disable ModBus RTU slave on T2S-ETH.
Disable

567 Slave address 1,2,… Set slave address for ModBus RTU.

568 Baud rate

9600

Set baud rate for ModBus RTU.
19200

38400

115200

569 Parity Even Odd No parity Set parity for ModBus RTU.
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Text ID Name Values Description

570 Stop bit(s)  1 bit , 2 bits Set stop bit(s) for ModBus RTU.

16.5	 Power

•	 General

Text ID Name Values Description

General

529

Redundancy

L1

Define the number of redundant modules for each phase.530 L2

531 L3

96
Source power 

ratio DC vs AC (%)
0 to 100

Defines the priority source. Default value is “0”

0 - Feeding from AC IN has priority (Inverter AC/AC - EPC mode) 

100 - Feeding from DC has priority (Inverter DC/AC - On Line mode)

102 Booster 10X Iin
Enable Allow to inhibit the Booster option which generates a current of  

10In for 20ms in case of short-circuit  
(For Nova inverter - 9In for 20 ms).Disable

547 AC in present

Enable If enabled the T2S ETH monitor and display the AC input source parameter 
in the web interface. 

If disabled, alarms related to AC source will be inactive and it will not 
display in the web interface.

Disable

104
AC In grid feed 

Disable
Enable

If enable, power will re-inject to AC input source.
Disable
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•	 AC In

Text ID Name
Values

Description
230 Vac 120 Vac

AC In

637 Number of AC In 1 to 3 Define the number of AC Input phase

AC In

56

Vac Low Stop 182 98

Define the minimum and maximum for AC Input voltage range.

Note: AC input low and high values have fixed hysteresis between stop 
and restart. Hysteresis is fixed to 10 Vac for 230 Vac module and  
5 vac for 120 VAC modules.

57 

58 

52

Vac Low Transfer 185 10053 

54 

48

Vac Low Start 195 10549 

50 

60

Vac High start 255 13561 

62 

64

Vac High Transfer 260 13965 

66 

68

Vac High Stop 265 14069 

70 

73 Freq AC Low Stop 47.0 57.0

Define the minimum and maximum of AC input frequency range.

Note: It is recommended not to change the AC input frequency values.

72 Freq AC Low Start 47.3 57.3

74 Freq AC High Start 52.7 62.7

75 Freq AC High Stop 53.0 63.0

97 Synchro speed (s) -2, -1, 0, 1 & 2
Set the speed at which modules try to synchronize AC output with AC 
input. Integer from -2 (very fast) to 2 (very slow).

101
Mode On Line 

(Safe)

Enable
If enabled, Load feed by DC source. If DC out of range, Load transfer to AC 
IN with delay transfer of 10 ms.

Disable
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•	 DC Group

Text ID Name
Values

Description
24 Vdc 48 Vdc 60 Vdc 110 Vdc 220 Vdc

DC Group

16
Vdc Low Stop 19.0 39.0 49.0 90.0 165.0

Define the minimum and maximum of DC 
input voltage range.

Note: It is recommended not to change the 
DC input values.

17 

8
Vdc Low Transfer 19.5 40.0 50.0 92.0 169.0

9 

0
Vdc Low Start 23.0 45.0 56.0 100.0 18.0

1

24
Vdc High Start 31.0 57.0 71.0 150.0 280.0

25 

32
Vdc High Transfer 34.5 60.0 74.0 158.0 296.0

33

40
Vdc High Stop 35.0 61.0 75.0 160.0 300.0

41 

593
DC Source Low 

Threshold
0 to 300

Set DC source low threshold voltage in 
volts. If DC source voltage drops under 
this threshold a “DC source low” alarm is 
raised.”

•	 AC Out

Text ID Name Values Description

230 Vac 120 Vac

AC out

78

Phase shift

L1 - 0.00 Phase shift between AC input phase 1 and AC output phase 1.

79 L2 - 120.00 Phase shift between AC input phase 1 and AC output phase 2.

80 L3 - 240.00 Phase shift between AC input phase 1 and AC output phase 3.

86

Vout nominal

L1 - 230 L1 - 120 Define AC output voltage for AC output phase 1, 2 and 3.

Output voltage per phase can be selectable 

(N-L : 200 V,220 V, 230 V & 240 V)

87 L2 - 230 L2 - 120

88 L3 - 230 L3 - 120

76 Nominal Freq 50 60 Free running AC output frequency when AC input is not available.

77 Nb of phases 1 to 3
Define the number of system output phase. 

It should be same as number of AC input phase. 

94
Short Circuit 

Voltage Threshold 
(V)

80 60
Minimum AC output voltage under which module considers output as in 
short-circuit.

95
Short Circuit Hold 

Time (s)
1 to 60

Default value is 60 seconds. This is the maximum time duration during 
which module tries to eliminate the short-circuit existing on output. If 
the voltage remains under the “Short Circuit Voltage Threshold” for this 
duration the module stops.

98
Max Power 

Derating (%)
150%  (TSI)

125%  (ECI)

Maximum power that module can supply.

99
Max Current  
Derating (%)

Maximum current that module can supply.
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Text ID Name Values Description

230 Vac 120 Vac

100
Max Overload  
Duration (s)

15 to 600 s Maximum time duration in seconds for modules to run in overload.

592
Saturation 
Threshold

80
Set saturation threshold in %. If the saturation i.e. the ratio between 
output power and rated power reaches this threshold an “Output 
saturated” alarm is raised.

107 Delta Mode
Enable

Enable Delta Mode, if the load has 3 phase input, without Neutral.
Disable

•	 Synchronization 

Text ID Name Values Description

Synchronization
TUS (TSI Universal Synchronization) is used for paralleling the system 
having more than 32 numbers of modules.

638 Sync Type

Disable

Select the type of synchronizator module (TUS) in the system.ALS

PLS

105
In case of sync 

failure

Never stop
Select the expected behavior of the system in case of synchronization 
failure.

Stop after 1 min

Stop directly

118
Number of sync 

modules
1 or 2 Set number of TUS modules in the system.

119 System ID 1, 2, 3, ..... Set the ID for each sub-system and T2S ETH must have a different ID.

120 Output phase ID 1
Select the sub-system phase. Each sub-system belongs to one and only 
one output phase.

121 Group ID 1

This parameter is used for configuring A + B system. In this case Group 
ID can be either 1 or 2 if sub system belongs to group A or group B. These 
systems can be either mono dual or tri-phases given the output phase ID 
configured.

122
Number of lines in 

system
3

Set the number of lines in the system. 

This is the number of phases.

123
Aux X power 
supply alarm

Don’t care

Set the option as “Don’t care”
On AC source

124
Aux Y power 
supply alarm

On DC source

Via module

125 DC sync ID
Disable

If each sub-system has its own independent DC group then this 
parameter should be set to ‘0’. If the user want to share a DC group 
between multiple sub-systems all of these should have the same value for 
this parameter.DC 1 to DC 8
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•	 Other

Text ID Name Values Description

103
Remote Off 

Disable AC Power
Enable Enable special mode in which “remote off” disables only AC input stage. 

AC input source is still used for synchronization.Disable

106
 Other;Walk In 

Mode Time (x10 
s.)

Integer 
The Walk-in mode allow at the TSI to comeback progressively on

the AC priority source after an outage. Friendly use on Genset.

108 Airco Mode
Enable Enable airco mode. It allows to start load with high inrush current and it is 

applicable only for TSI modules.Disable

109
Force Start 
Without T2S

Enable
Enable modules start without T2S

Disable

110 Pdc Max (W) 0.000000

Maximum power allowed on DC even during overload. 

0 means no limit.

111
No power from 
ACin phase 1

Enable

Not Applicable for EPC mode operation.

It is recommended to set in “Disable” 

Disable

112
No power from 
ACin phase 2 

Enable

Disable

113
No power from 
ACin phase 3 

Enable

Disable
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17.	 Annex 4: Modbus

17.1	 Hardware Requirements

17.1.1	 Cabling:

ModBus RTU is available on the RJ45 connector located on the back plane of the rack containing the T2S ETH 
controller. The below image provides the pinout details of the connector. 

Pin Number Name Description

1 CANH CANH pin for Candis

2 CANL CANL pin for Candis

3 GND_IAX Digital Communication Ground

4 GND_IAX Digital Communication Ground

5 12V_IAX +12 V unregulated

6 COM_A RS 485 A

7 GND_IAX Digital Communication Ground

8 COM_B RS 485 B

17.1.2	 Baud rate, parity and mode

Only RTU mode is supported.

Item Value Default

Slave address From 1 to 247 1

Baud Rate 9600, 19200, 38400 or 115200 19200

Parity Even, odd, none Even

Stop bits One, two One

Mode RTU -

Electrical interface RS485 -
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17.2	  Database Description

17.2.1	 Typographic convention:

In this document, the following naming convention will be used to represent the type of a variable:

The first letter will indicate if the variable is signed (S) or unsigned (U). Then the following digit(s) will indicate the 
number of bits needed to store the variable.

Thus:

 � U8 will represent an unsigned variable stored in an 8-bit wide memory

 � U16 will represent an unsigned variable stored in a 16-bit wide memory

 � U32 will represent an unsigned variable stored in a 32-bit wide memory

And:

 � S8 will represent a signed variable stored in an 8-bit wide memory

 � S16 will represent a signed variable stored in a 16-bit wide memory

 � S32 will represent a signed variable stored in a 32-bit wide memory

What is more, the Modbus RTU register base type is a 16-bit wide variable. This means it is possible to store two 8-bit 
variables in a register. These two variables will be accessed using the same index in the structure. Thus in order to 
know if the variable is stored in the upper byte or in the lower byte, letter H(High) or L(Low) is added to the index. 

As specified by the protocol, variables longer than 8-bit are always represented in big-Endian format (MSB first).

17.2.2	 Data types:

Modbus RTU protocol defines four types of variables class described in the following table.

Name Type Access Supported by T2S ETH

Discrete input 1-bit wide Read-only No

Coil 1-bit wide Read-write No

Input register 16-bit wide Read-only Yes

Holding register 16-bit wide Read-write No

Data address mapping and signification are described in the following sections.

17.2.3	 Supported function:

Accordingly to Modbus RTU specification, supported functions by the T2S ETH controller are the following:

 � Read Input registers (0x04)
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17.2.3.1	 INPUT REGISTERS ELEMENTS (Read-Only 16-bit wide)

Module table (0x0000)

The table described below represents the information that can be retrieved regarding a particular module. The 
Maximum amount of the module is set to 32. Each of them is identified by an address ranging from 1 to 32.

BASE ADDRESS: 0(0x0000) + 31*(Module address – 1).

Index Name Description Type

0H eStatusACOut AC output status number (see 17.3.1.1, page 88) U8

0L eStatusACIn AC input  status number (see 17.3.1.2, page 89) U8

1H eStatusDCIn DC Input  status number (see 17.3.1.3, page 89) U8

1L bAddress Configured address U8

2H bLoadPosition
Position of the load regarding input power sources (0:AC, 100:DC, 50:mixed, 
101:unknown)

U8

2L bLoadRatioW Loading ratio regarding power in watts (%) U8

3H bLoadRatioVA Loading ratio regarding power in VA (%) U8

3L bPhaseNumber Number of the phase module is belonging to U8

4 wVout Output voltage value (0.1V) U16

5 wIout Output current value (0.1A) U16

6 wPoutW Output power value (W) U16

7 wPoutVA Output power value (VA) U16

8 wVinAC AC input voltage value (0.1V) U16

9 wIinAC AC input current value (0.1A) U16

10 wPinACW AC input power value (W) U16

11 wPinACVA AC input power value (VA) U16

12 wACInFreq AC input frequency value (0.1Hz) U16

13 wVinDC DC input voltage value (0.1V) U16

14 wIinDC DC input current value (0.1A) U16

15 wPinDC DC input power value (W) U16

16 wTemperature Temperature value (K) U16

17 wSoftVersion Software version number U16

18 lSerialNumber Serial number U32

22H bStatusMod
Event number of the status related to the output stage and the module internal 
status

U8

22L bStatusAC Event number of the status related to the AC input stage U8

23H bStatusDC Event number of the status related to the DC input stage U8

23L bPresent Flag (true or false) that indicates if module is seen by T2S ETH or not U8

24H bGroupAC AC input group number module is belonging to U8

24L bGroupDC DC input group number module is belonging to U8

25H bRestrained
Flag (true or false)that indicates if module cannot cope with more than five 
other module or not

U8

25L bNoEPC Flag (true or false) that indicates if module has an AC input (EPC) or not U8

26 wPoutNominalW Nominal output power (W) U16
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Index Name Description Type

27 wPoutNominalVA Nominal output power (VA) U16

28 wVinNominalAC Nominal AC input voltage (0.1V) U16

29 wVinNominalDC Nominal DC input voltage (0.1V) U16

30 wVinNominalFreqAC Nominal AC frequency (0.1Hz) U16

Phase table (0x0640)

The following table described represents the information that can be retrieved regarding a particular phase. The 
Maximum amount of phase is set to 8. Each of them is identified by a label ranging from 1 to 8.

BASE ADDRESS: 600(0x0640) + 27*(Phase label – 1).

Index Name Description Type

0H bRatioAvailableW Ratio between output load and available power in watts (%) U8

0L bRatioAvailableVA Ratio between output load and available power in VA (%) U8

1H bRatioInstalledW
Ratio between output load and installed power (Nb modules – redundancy) in 
watts (%)

U8

1L bRatioInstalledVA
Ratio between output load and installed power (Nb modules – redundancy) in 
VA (%)

U8

2 wVout Output voltage value (0.1V) U16

3 wIout Output current value (0.1A) U16

4H bNbOndCfg Number of modules configured in the phase U8

4L bRedundancy Amount of redundancy configured in the phase U8

5 wACOutFreq AC output frequency value (0.1Hz) U16

6 lPinDC DC input power value (W) U32

8 lPinACW AC input power value (W) U32

10 lPinACVA AC input power value (VA) U32

12 lCurrentPowerInVA Output power value (VA) U32

14 lCurrentPowerInW Output power value (W) U32

16 lInstalledPowerInW Installed power value (W) U32

18 lInstalledPowerInVA Installed power value (VA) U32

20 lAvailablePowerInW Available power value (W) U32

22 lAvailablePowerInVA Available power value (VA) U32

24H bNbInvSeen Number of module seen by T2S ETH in that phase U8

24L bNbInvOK Number of modules that are delivering output in the phase U8

25H bNbInvMO Number of modules manually off in the phase U8

25L bNbInvKO Number of modules that are not delivering output due to a failure in the phase U8

26H bNbInvNT
Number of modules not seen by T2S ETH in the phase (accordingly to 
bNbOndCfg)

U8
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AC group table (0x0730)

The table described below represents the information that can be retrieved regarding a particular AC group. The 
Maximum amount of AC group is set to 4. Each of them is identified by a label ranging from 1 to 4.

BASE ADDRESS: 1840(0x0730) + 10*(AC group label – 1).

Index Name Description Type

0H bNbInvOK Number of modules that are delivering output in the group U8

0L bNbInvMO Number of modules manually off in the group U8

1H bNbInvKO Number of modules that are not delivering output due to a failure in the group U8

1L bNbInvSeen Number of module seen by T2S ETH in that group U8

2 lPinACW AC input power value (W) U32

4 lPinACVA AC input power value (VA) U32

6 wVinAC AC input voltage value (0.1V) U16

7 wIinAC AC input current value (0.1A) U16

8 wACInFreq AC input frequency value (0.1Hz) U16

9H bACInOk Number of modules stating that their AC input stage is fully functional U8

DC group table (0x076C)

The table described below represents the information that can be retrieved regarding a particular DC group. The 
Maximum amount of DC group is set to 8. Each of them is identified by a label ranging from 1 to 8.

BASE ADDRESS: 1900(0x076C) + 7*(DC group label – 1).

Index Name Description Type

0H bNbInvOK Number of modules that are delivering output in the group U8

0L bNbInvMO Number of modules manually off in the group U8

1H bNbInvKO Number of modules that are not delivering output due to a failure in the group U8

1L bNbInvSeen Number of module seen by T2S ETH in that group U8

2 lPinDC DC input power value (W) U32

4 wVinDC DC input voltage value (0.1V) U16

5 wIinDC DC input current value (0.1A) U16

6H bDCInOk Number of modules stating that their DC input stage is fully functional U8

Miscellaneous information table (0x07BC)

The table described below represents the miscellaneous information that can be retrieved regarding T2S ETH and 
system. 

BASE ADDRESS: 1980(0x07BC)  

Index Name Description Type

0H bOldVersionNumber Deprecated. Always 0x00 U8

0L ePhaseNumber Number of phase configured in the system U8

 Annex 4: Modbus

86 - Monitoring - T2S ETH with Inview X- User Manual - v3.2



Index Name Description Type

1 lSerialNumber T2S ETH serial number U32

3 wTempoMajorAl Temporization of major alarm relay U16

4 wTempoMinorAl Temporization of minor alarm relay U16

5H bNbMajor Number of major alarm in the system U8

5L bNbMinor Number of minor alarm in the system U8

6H bNbTotalAlarmNumber Total number of alarm in the system U8

6L bACInputPresent
Flag (true or false) that indicates if AC input should be considered as 
present or not

U8

7H bSaturationThresh Value of the ratio over which the saturation alarm will be raised (%) U8

7L bNbGroupsDC Number of DC groups configured in the system U8

8H bNbGroupsAC Number of AC groups configured in the system U8

8L bProgRelay Always 0xFF U8

9 wSoftMainRevision Main revision software number of T2S ETH U16

10 wSoftSubRevision Sub revision software number of T2S ETH U16

11H bSystemLoadPosition
Position of the load at the system level (0:AC, 100:DC, 50:mixed, 
101:unknown)

U8

11L
bT2S 
ETHMaxKnownParameters

Version number of TSI modules configuration parameters U8

13H bNbrModConf Total number of module configured on the installation U8

13L bNbrModSeen Total number of module configured on the installation U8

Date and time table (0x07D0)

The table described below represents the information that can be retrieved regarding date and time. 

BASE ADDRESS: 2000(0x07D0)

Index Name Description Type

0 lTime Time in epoch U32

2H bSeconds Seconds number U8

2L bMinutes Minutes number U8

3H bHours Hours number U8

3L bDay Day of the month U8

4H bMonth Month number U8

4L bDaylightSaving Flag (true or false) that specify if daylight saving is enable or not U8

5 wYear Year number U16

Alarm table (0x07DA)

The table described below represents the information that can be retrieved regarding alarms. Maximum amount of 
entries is set to 50. A valid entry represents an alarm present in the system. An invalid entry is an entry where all bits 
of each field are set. All entries following an invalid entry will be invalid.

BASE ADDRESS: 2010(0x07DA) + 2*(Entry number – 1)
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Index Name Description Type

0H bDeviceNumber
Identifier that specifies which device is responsible of this alarm  
(see 17.3.1, page 88)

U8

0L bEventType Type of the alarm (Major or minor) (see 17.3.1, page 88) U8

1 wEventNumber Alarm number identifier U16

Rem: See alarm types in the annexes for bEventType description.

Configuration table (0x1040)

The table described below represents the information that can be retrieved regarding parameters that can be 
configured in the T2S ETH controller. Maximum amount of entries is set to 500. Not all entries are valid. An invalid entry 
is an entry where all bits of each field are set. Invalid entries might be interleaved with valid entries.

BASE ADDRESS: 4160(0x1040) + 20*(Entry number – 1)

Index Name Description Type

0 swParameter Configured value of the parameter S16

1 wValidity
Value indicating if last configured parameter value is valid  
(see 17.3.4, page 90) 

U16

2 wIdentifier Unique value identifying the parameter U16

3 wUnit
Value indicating in which units the parameter is expressed  
(see 17.3.4, page 90)

U16

4 strParamDescription Textual description of the parameter 32*U8

Event string table (0x4114)

The table described below represents the information that can be retrieved regarding event textual description. 
Maximum amount of entries is set to 300. Each event is identified by an unique number (Event 0 exists!).

BASE ADDRESS: 16660(0x4114) + 8*Event number

Index Name Description Type

0 strEventTxt Textual description of event 16*U8

17.3	 Status and Constants Description

17.3.1	 Module status explanation (A1):

17.3.1.1	 eStatusACOut:

Name Description Value

SBR Standby running. This means that the module is delivering output 0

SB Standby. This mean that the module is manually OFF 1

SBWE
Standby with error. This means that the module is not delivering 
output due to an unrecoverable error

2
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Name Description Value

SBWRE
Standby with recoverable error. This means that the module is not 
delivering output due to a recoverable error.

3

UNKNOWN Unknown. This means status is unknown 4

17.3.1.2	 eStatusACIn:

Name Description Value

OK OK. This means the AC input is OK for the module 0

SAFE
Safe. This means the AC input is not considered as “good” but 
some power can still be drawn from it.

1

NOT_SYNC
Not synchronized. This means that the AC input and output are not 
synchronized together thus invalidating AC input.

2

OFF
Off. This means that the AC input stage of the module has been 
turned off due to an invalid AC input (maybe not safe).

3

UNKNOWN Unknown. This means the status is unknown 4

17.3.1.3	 eStatusDCIn:

Name Description Value

OK OK. This means the AC input is OK for the module 0

FAIL Fail. This means the DC input voltage is out of valid range. 1

UNKNOWN Unknown. This means the status is unknown 2

17.3.2	 Alarm types:

Name Description Value

NO_ALARM Defines an event that is not considered as an alarm 0

MINOR Defines an event that is to be considered as a minor alarm 1

MAJOR Defines an event that is to be considered as a major alarm 2

17.3.3	 Alarm sources:

Name Description Value

T2S ETH Device responsible of the alarm is the T2S ETH controller. 0

MOD XX
Device responsible of the alarm is the module number XX where 
XX is the value

1-32

SYSTEM
Source of the alarm is the whole system (e.g. if all module are 
sharing the same alarm).

33
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17.3.4	 Validity and Unit description (A2):

wValidity should be interpreted as follow:

Name Description Value

PARAM_OK Parameter value is valid 0

PARAM_TOO_LOW Parameter value is too low 1

HYST_TOO_LOW
Parameter value is in an acceptable range but is too close from 
another related parameter value

2

PARAM_TOO_HIGH Parameter value is too high 3

TSI_MUST_BE_OFF
Parameter value can only be changed if TSI modules are not 
delivering output

4

BAD_VALUE Parameter value is not acceptable 5

INV_MISMATCH Parameter cannot be configured for that type of module 6

wUnit is divided in two part:

 � High byte is exponent value for parameter conversion (e.g. 2 means to be divided by 10² = 100).

 � Low byte represents the unit in which the parameter is expressed. This unit can be one of the one 
represented in the array below.

Name Description Value

NO_UNIT No unit. Represented by a blank character 0

VOLT Volt.    Represented by the “V” character 1

AMPERE Ampere.  Represented by the “A” character 2

HERTZ Hertz.   Represented by the “Hz” characters 3

SECOND Second.  Represented by the “s” character 4

ANGLE Angle.   Represented by the “deg” or “°” characters 5

WATT Watt.    Represented by the “W” character 6

VA VA.      Represented by the “VA” character 7

PERCENT Percent. Represented by the “%” character 8

DEGREE Degree.  Represented by the “deg” or “°” characters 9

OHM Ohm.     Represented by the “Ohm” character 10

Example: if wUnit value is 0x0201 the parameter is expressed in centiVolts.

17.4	 Modbus over RTU

17.4.1	 Introduction

In all the following examples, assumption will be made that T2S ETH controller Modbus RTU slave address is 1 (0x01).

17.4.1.1	 Reading simple variables:

Ex 1: Reading output voltage of module #5
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Field Value Description

Function 4 (0x04) Read input register

Address 128 (0x0080) 31*(5-1) + 4 = 128 (see module table, page 84)

Number of registers 1 (0x01) Vout value is 16-bit wide

Master frame: 0x01 0x04 0x00 0x80 0x00 0x01 0x71 0xE3

T2S ETH frame: 0x01 0x04 0x02 0x09 0x1B 0xFF 0x6B

Received value: 0x091B = 2331  Output voltage is 233.1V (see module table, page 84)

Ex 2: Reading T2S ETH serial number

Field Value Description

Function 4 (0x04) Read input register

Address 128 (0x0080) 31*(5-1) + 4 = 128 (see module table, page 84)

Number of registers 1 (0x01) Vout value is 16-bit wide

Master frame: 0x01 0x04 0x07 0xC5 0x00 0x02 0x60 0x82

T2S ETH frame: 0x01 0x04 0x04 0x00 0x01 0x00 0x07 0xEB 0x86

Received value: 0x0001 and 0x0007  T2S ETH revision is Vs1.7 

17.4.1.2	 Reading alarm and history log:

Reading entry #1

Field Value Description

Function 4 (0x04) Read input register

Address 2010 (0x07D4) 2010 + 2*(1-1) = 2010 (see alarm table, page 87)

Number of registers 2 (0x02) Alarm entry is 2 registers wide

Master frame: 0x01 0x04 0x07 0xDA 0x00 0x02 0x51 0x44

T2S ETH frame: 0x01 0x04 0x04 0x21 0x01 0x00 0xB3 0xE1 0xCD  

Alarm entry #1 is a minor (0x01) alarm generated by the system (0x21) and this alarm has the ID 179 (0x00B3)

Reading an invalid entry

Let’s assume that there are only 2 alarms present in the system. Then reading alarm entry #3 should return an invalid 
entry

Field Value Description

Function 4 (0x04) Read input register

Address 2014 (0x07DE) 2010 + 2*(3-1) = 2014 (see alarm table, page 87)

Number of registers 2 (0x02) Alarm entry is 2 registers wide
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Master frame: 0x01 0x04 0x07 0xDE 0x00 0x02 0x10 0x85

T2S ETH frame: 0x01 0x04 0x04 0xFF 0xFF 0xFF 0xFF 0xFA 0x10  

Conclusion, there is no alarm entry #3 and nor are there further entries. This leads to the conclusion that only 2 alarms 
are present at the time in the system.

Linking alarm ID to alarm description text:

If we consider the alarm ID #179 of example above, we can get description text for this alarm by reading related entry 
in the “Event string table”.

Field Value Description

Function 4 (0x04) Read input register

Address 18092 (0x46AC) 16660 + 8*179 = 18092 

Number of registers 8 (0x08) Event description string is 16 characters long

Master frame: 0x01 0x04 0x46 0xAC 0x00 0x08 0x24 0xA5

T2S ETH frame: 0x01 0x04 0x10 0x56 0x61 0x63 0x5F 0x69 0x6E 0x20

0x54 0x4F 0x4F 0x20 0x4C 0x4F 0x57 0x20 0x20 0x36 0x7C

String description: Vac_in TOO LOW 

17.4.1.3	 Reading configuration:

Reading entry #1

Field Value Description

Function 4 (0x04) Read input register

Address 4160 (0x1040) 4160 + 20*(1-1) = 4160 

Number of registers 20 (0x14) Alarm entry is 20 registers wide

Master frame: 0x01 0x04 0x10 0x40 0x00 0x14 0xF5 0x11

T2S ETH frame: 0x01 0x04 0x28 0x01 0xB8 0x00 0x00 0x01 0x04 0x01

0x01 0x44 0x43 0x20 0x31 0x20 0x3A 0x20 0x56 0x64

0x63 0x5F 0x69 0x6E 0x20 0x4C 0x6F 0x77 0x20 0x53 

0x74 0x61 0x72 0x74 0x20 0x20 0x20 0x20 0x20 0x20

0x20 0x20 0x20 0x64 0x36

Configured Value: 0x01B8  440

Validity: 0x0000  PARAM_OK (see 17.3.4, page 90)

Parameter ID: 0x0104  260

Units: 0x0101  unit is dV (0.1V) (see 17.3.4, page 90)

String description: DC 1 : Vdc_in Low Start
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Reading an invalid entry

Let’s assume that entry #189 is invalid

Field Value Description

Function 4 (0x04) Read input register

Address 7920 (0x1EF0) 4160 + 20*(189-1) = 7920 

Number of registers 20 (0x14) Alarm entry is 20 registers wide

Master frame: 0x01 0x04 0x1E 0xF0 0x00 0x14 0xF6 0x1E

T2S ETH frame: 0x01 0x04 0x28 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 

0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF

0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF

0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF 0xFF

0xFF 0xFF 0xFF 0xF0 0x04

Due to internal memory organization, the configuration might have valid entries interleaved with invalid ones. Thus, in 
order to read all configurations, one should read all entries to determine which ones are valid and which ones are not.

Exceptions: Textual parameter

The configured value field is 16 bit wide. Consequently, only integer values can be read (or further configured) using 
this way. There are 3 parameters that are not integer values but strings. Thus, the values returned in the “Configured 
value” field of the configuration table for those 3 IDs are dummy values that have no meaning.

Those IDs are the following

ID Description Remark

901 Digital input 1 label
Can be read in the digital inputs table in the 
holding registers (0x0686)

902 Digital input 2 label
Can be read in the digital inputs table in the 
holding registers (0x0686)

Note 1:

Caution should be taken while changing the module address because it will affect the addresses where to retrieve 
information regarding this module. What is more, there can be a delay between the moment where the change address 
order is received and the moment where the module address has been physically changed. Moreover, a module 
address can be changed to a new address that is already assigned to another module! In this case, the modules will 
swap their addresses.

For all those reasons, the best and secure way to change a module address is the following one:

1.	 Get module serial number using “Module information table” using the current address to calculate the index.

2.	 Send to the new address for this module using the “Module action table” using the current address to calculate 
the index.

3.	 Poll the serial number using “Module information table” using the new address as index until there is a match 
with the serial number collected at point 1.
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